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1.  OVERVIEW 

Trade Import Expert™ 

Trade Import Expert™ from Software Intelligence, Inc. solves the time critical, error-
prone task of translating unstructured files into validated trade lists.  TIE™ can convert 
a document into an order instantly. 

The Business Problem 

When a program trade arrives at an agency desk, traders focus on how to convert the 
file instead of on how to trade the list.  While converting the file a trader’s attention may 
be diverted from trading for minutes.  A typical trader might use Excel™, a custom 
program, or a combination of both, to extract the information required to create and 
confirm the order.  If the desk is trading several large market orders simultaneously, the 
task of conversion becomes unmanageable.  Trade Import Expert™ solves this 
problem. 

The Business Solution 

With Trade Import Expert™ the computer does the work.  TIE™ computes the trade list 
from the input file instantly.  It reads the input, extracts the orders, reconciles its results, 
generates a summary and a bid sheet, and outputs a fully validated trade list.  
 
In addition, TIE™ detects semantic errors and filters out unwanted text.  TIE™ can be 
used as a trading desk’s primary list converter, or as a reference tool, providing 
secondary order confirmation.  After a list is converted, it can be routed as a FIX 
message, saved to a database, or integrated into a trading application with an API. 
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2.  TIE™ BASICS 

Overview 

Trade Import Expert™ (TIE™) translates unstructured files into validated trade lists. 

TIE™ Organization: The Folders 

 

 
 
TIE™’s folder system works like a pipeline.  There are Input folders (Input, Excel™ and 
Tabular), Output folders (Country, Total, Buy, Sell, Cover, Short, Buy-, Sell+, Exempt, 
and Unknown), and Report folders (Trade Summary Report, Errors, Account, Odd Lot, 
Mismatch, Price, Restrict, Daily, Bid, International Liquidity, US Liquidity, and OTC 
Market Maker- the last three are optional reports and not pictured here).  Each of the 
folder tabs displays an initial (I, O, or R) indicating whether it is an input, output or report 
folder. 
 
The Input and Excel™ folders send original data downstream into the Tabular folder 
where data can be edited, “set”, and where order feedback and error messages guide 
the user in the appropriate steps to convert the order. 
 
The Tabular folder sends its converted results downstream into the Country, Total, 
‘Side’, and Unknown folders.  Any editing changes made in the Total folder will be 
reflected in the Country, ‘Side’ and Report folders. 

Inputting Orders in TIE™ 

Overview 

TIE™ provides four ways to input an order: drag and drop, file open, copy and paste, 
and manual entry. 

Drag and Drop 

From Exploring or from Outlook Express, users may click on a file and drag a file into 
TIE™. 

File Open 

Files may be opened from the file menu located in the upper left of the TIE™ screen. 
Select File > Open. A dialog box pops up allowing users to navigate through their 
directories, select a file, and open it into the TIE™ screen.  The file will display in 
TIE™’s Tabular folder. 

Copy and Paste 

Data from any text or Excel™ document can be copied and pasted into the TIE™ grid 
from the clipboard. 

Manual Entry 

Data may be entered manually in the Excel™ folder. When data entry is complete, the 
user must click on the Convert button for the data to be processed and appear in the 
Tabular folder.  Click on the Tabular folder to view errors and status.  
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Processing Orders: The Convert Button 

Clicking the Convert button processes the data. Any time data is “set”, accounts are 
“set”, a client is “set”, or any editing change are made, the user must click on the 
Convert button to process the new information. 

The “Set” Buttons 

Manually Setting Order Attributes 

In TIE™ we refer to data that gives information about an order as an “order attribute”.  
Order attributes include: side, shares, accounts, security identifiers (such as cusip, 
sedol, ISIN, etc.).  There are a series of order attribute “Set” buttons located on TIE™’s 
toolbar for manually setting order attributes. 
 
Setting an order attribute identifies the type of data in a cell, range, or column.  It 
guarantees that the data will not be ambiguous. 
 
Example:  A share quantity may resemble a quick code, sedol, kassenverein, etc. Country codes, 
currency codes, exchange abbreviations, account names and tickers may resemble each other.   
By setting a cell, range, or column containing data, the data is designated and will not create 
ambiguity conflicts. 

Setting Security Identifiers 

When more that one security identifier (such as ticker, cusip, sedol, valoren, ISIN, etc) 
appears in a list, setting one security identifier gives that identifier precedence over the 
others. 
 
Example:  For instance, if tickers and cusips are the security identifiers in a list and there is a 
ticker/cusip conflict (the ticker and cusip don’t match the same security), setting the cusip column 
will give the cusips precedence.  The security selection will be made based on the cusips.  This 
will resolve the conflict(s). The tickers will be ignored except when a cusip is not known, in which 
case TIE will look for the next identifier present in that row (i.e. - ticker). 

Eliminating Superfluous Data 

The more concise the data is, the more easily the file will convert. It is always a good 
idea to cut away columns of unnecessary data. 
 
Note:  If TIE™ does not recognize the data in a certain column it may ask the user to “Cut or Set” 
the column.  These instructions will appear in the Status Column of the Tabular folder for rows 
containing ambiguity. 

Checking For Errors 

The fastest way to see security rows that did not convert into orders is to click on the 
Unknown folder tab.  The Unknown folder displays only the rows that could not be 
converted. 
 
Note:  The Tabular folder is the central folder for viewing and editing a trade list.  Error 
messages are displayed in the Status Column for each row of data in the Tabular folder 
that did not convert to an order, unless the status reads “Order.”  Clicking on a row in 
the Tabular folder displays the expanded error message or order details in the Status 
Bar at the bottom of the screen. 
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Correcting Errors 

Making corrections in the Tabular folder 

The user may manually edit, set, or cut data in the Tabular folder and click on the 
Convert button to have the new results applied to the Output and Report folders. 

Making corrections in the Unknown folder 

The user may manually edit, set, or cut data in the Unknown folder and click on the 
Convert button to have the results applied to the Output and Report folders.  The 
changes will not be applied to the Tabular folder, however, because the Tabular folder 
is “upstream” from the Unknown folder. 
 
Note:  It is recommended that editing changes be made in the Tabular folder if the trader wants to 
be able to view the input list with the editing corrections applied.  However, for trade lists 
containing several hundred or several thousand rows of data, using the Unknown folder is the 
fastest way to locate and correct errors. 

Reference Dialog Boxes 

TIE™’s toolbar includes a series of buttons marked with the letters “REF”.  Each button 
brings up a reference dialog box.  These are reference tools for the trader’s 
convenience.  They can be used to look up exchange rates, transaction costs, side 
abbreviations, security data, client accounts and more.  The reference dialog boxes 
also provide the user the ability to update, delete, and add new data. 
 
There are a total of seven reference dialog boxes.  These include the: Set Client dialog 
box, Security Reference, Account Reference, Side Reference, Country Reference, FX 
(Foreign Exchange Reference), and Client Reference. 

FastFind 

To search for information using FastFind, select a cell by clicking on it, hold down the 
Shift key and click right on the mouse.   Shift + Right Click 
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Basic File Conversion 

1. Input an order into TIE™ 

There are several ways a user may do this: 

• From Windows® Exploring locate the file and drag it onto the TIE™ grid.  (From 
Outlook Express® a user may drag email attachments directly onto the TIE™ 
grid.) 

• From non-Windows® platforms select File > Open from TIE™’s menu and 
navigate to the file in the directory. 

• Files may be copied and pasted into the TIE™ grid. 
 

 
 

2. Set the Client 

 
The Set Client dialog box will appear. 

To set the client: 

1. Scroll through the Client list and click on the client. 
2. Click the Set Client button 
3. Click the Done button to close the dialog box. 
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3. View the Trade List 

To view and edit the trade list click on the Tabular folder tab, if you are not already in 
the Tabular folder. 

 

 
 
The Tabular folder will display status messages in the Status Column for each row of 
data in a list. 
 
Click on any row to show the expanded order status in the Status Bar at the bottom of 
the screen. 
 
In the picture above, note that row 21 has been highlighted.  The Status bar at the 
bottom of the screen shows the errors (company description mismatch) and the order 
summary (side: SL, shares: 1,400, ticker: C, RIC, C.N, cusip: 172967101, country: 
USA, price: 50.860, and the company name from the database: Citigroup Inc.). 

4. Cut out extra columns  

Cut out any unnecessary data that may cause conflicts. 
To remove the column: 
1. Click on the column header (this will highlight the entire column). 
2. Click on the Cut button with the scissors icon located on TIE’s Toolbar. 
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5. Set Order Attributes 

To Set the Security Identifier: 
In this example we will use the cusip as our security identifier. 
 
1. Click on the (security identifier) cusip column header so that the entire column is 

highlighted.  
2. Click on the Set Cusip button. 
 
An asterisk will appear in the column header once a column has been "set."  
 
You may also set individual cells by highlighting the cell, clicking on the security id "set" 
button and then clicking the "Convert" button. 
 
To Set the Price: 
In this example we will set the price column as Local Price.  
 
1. Click on the Price column header to highlight the entire column. 
2. Click on the Set Local Price button. 
 
You may only set one price column: either Local Price or USD Price, but not both.  
TIE™ will base its reference price calculations on the price column you have set. 
 
To Set the Shares: 
1. Click on the Share column header to highlight the entire column. 
2. Click on the Set Share button. 
 

6. Convert the Order 

To Convert the Order: 
Click on the Convert button. 
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Basic Editing 

By clicking on a row containing a "Mismatch" message in the Status Column, we can 
read the company name that the security identifiers point to in the Status Bar.  If these 
client names are different, the client data will have to be verified and corrected. 
 
To check the security identifiers, use FastFind to search by company name.: 
1) Place the cursor over company description cell  
2) hold down the shift key and simultaneously click on the right mouse button.  TIE™ 
will instantly perform a company search and bring up the Security Reference dialog box 
with its findings. 
3) Double click on one of the company names in the list box to view the security data. 
 
To select data you wish to copy and paste into TIE: 
1. Highlight the data (In the picture, above, the cusip has been highlighted.) 
2. Press Ctrl+C to copy the data. 
3. Click on the TIE grid. 
4. Highlight the cell or the data you would like to replace with the new data. 
5. Press Ctrl+V to paste the data into the cell. 
 
(In the picture below, we have highlighted and replaced the cusip.) 

 
 
6.   Or use FastFind's special FastFind Paste feature that allows you to replace all the 
security identifiers in the row simply by clicking on the Paste button in the Security 
Reference dialog box. 
7.    Click on the Convert button to reconvert the order. 
 
NOTE:  In the example above, had the cusip column been previously set, it would have to be re-
set after editing and then converted by clicking on the Convert button to process the new data. 
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3.  CONVERSION PROCEDURES 

Converting Canadian and Dually Listed Securities 

TIE™ has a variety of options for handling dually listed securities.  Since many US and 
Canadian companies share the same tickers and cusips, TIE™ will default to the US 
ticker and cusip.  The user may select other options for converting Canadian and Dually 
Listed securities. 
 

Reporting Dually Listed Securities 

Dually listed securities are reported in the following locations: 
 

• the Tabular folder Status Bar  

• the Comments field of the Total and side folders 

• the Dually Listed Securities section of the Report folder 
 

Alerting the user of Canadian securities in a list 

TIE™ provides the user the option of being alerted when a Canadian security appears 
in a list.  From the Tools Menu select Advanced Features. The Advanced Features 
dialog box has a "Prompt User for Canadian Securities" option.  Placing a check in the 
check-box enables a prompt that comes up each time a user drags in or converts a list 
containing Canadian securities. 
 
Note:  Once the Canadian Prompt is checked it will remain on when opening up new grid sheets. 
 

Changing the security selection of a Dually Listed Security: 

Changing individual securities 

If a user wants to change the country of an individual security (i.e.: from Canadian to 
US or visa-versa), this can be done in the Total folder by editing the Country cell for that 
security. 
 
Once edited, tabbing out of the cell will reconvert the dually listed security’s data to 
correspond with the country selected. TIE™ will only allow editing in the Total folder’s 
country column when a security is dually listed, and will only allow the "USA" or "CAN" 
country abbreviations. 
 

Selecting Canadian Securities each time a USA/CAN Dually Listed security appears 
– Advanced Features option 

If the user wants TIE™ to select the Canadian security each time a dually listed security 
appears in a list, TIE™ provides a check box to “Choose Canadian when Dually listed”. 
From the Tools Menu, select Advanced Features. Placing a check in the check box will 
cause TIE to default to the Canadian security instead of the US. 
 
Note:  The check box will remain checked or unchecked according to the user’s last setting when 
a new file is dragged in over a previous file.  The check box defaults to unchecked (choosing US 
securities when dually listed) each time a new grid sheet is opened. 
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Changing the country selection of dually listed securities for an entire list when 
uploading to the Trade Execution System  

When Canadian and/or dually listed securities are present in a list, TIE™'s Trade 
Execution System Upload dialog box will include two check-boxes. One uploads any 
dually listed securities to Trade Execution System as US (this is also the default if 
neither box is checked).  The other uploads any dually listed securities to Trade 
Execution System as Canadian.   
 
Note:  If the user wants dually listed securities to appear as Canadian in the Country folder and all 
subsequent reports, then the designation must be made during the conversion process. This can 
be done by editing the security data in the Tabular folder, editing the country in the Total folder, or 
by selecting the “Choose Canadian when Dually listed” check-box in Advanced Features under 
the Tools menu and converting. 

Processing Excel™ Spread Sheets 

Opening an Excel� Spread Sheet  

An Excel™ spreadsheet can be dragged into the Trade Import Expert™ grid or may be 
opened by using the Open File dialog box via the File menu or the Open File button 
located on the toolbar.  When an Excel™ spread sheet contains more than one 
worksheet, the trader can select worksheets in TIE™'s Excel™ folder. 
 

Viewing an Excel� Spread Sheet 

To view the contents of an Excel™ file, click on the Excel™ folder tab.  TIE™'s Excel™ 
folder displays the Excel™ grid as well as any Excel™ sheet tabs and a special scroll 
bar at the bottom of the screen. TIE™ will display the Excel™ worksheet that 
corresponds with the highlighted Excel™ tab.   
 

Selecting an Excel™ Worksheet 

To select a specific worksheet from a multiple-worksheet file, the user must click on the 
Excel folder, and then click on the worksheet tab.  Clicking on a specific worksheet tab 
will highlight that tab and display the corresponding data.  
 

Processing an Excel™ Worksheet 

To enter an Excel™ worksheet, into the Tabular folder for conversion, make sure the 
worksheet has been selected, by checking to see that the tab is highlighted and the 
appropriate list is being displayed, then click on the Convert button.  This will enter the 
data into the Tabular folder, where it can be viewed, edited, and attributes can be set. 

Editing an Excel™ Worksheet – see Chapter 4 

See Chapter 4:  Editing Procedures: Editing in the Various Folders: Editing in the 
Excel™ Folder for special editing options in the Excel™ folder. 

Removing Columns 

To Remove a Column: 

1. Highlight the column to be removed by clicking on the header of that column. 
2. Click on “cut” in the right-click mouse menu, the edit menu, or the button with the 

scissors icon, located at the top of the screen. 
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Options: 

• To remove more than one column at the same time, simply highlight all the columns 
to be removed and click on the “cut” option. 

• To include additional columns that are not adjacent, hold down the control key while 
you relocate the mouse and continue highlighting the desired columns. 

 
Note:  This feature is only supported in the Tabular, Excel™ and Unknown folders. 

Setting Ranges 

Using the Range Edit Controls 

Ranges may be specified by using the Range edit controls located in the Control Panel 
to the right of the grid.  The range is specified by typing the row numbers of the first and 
last rows in a range into the “Start” and “Stop” Range edit controls.   
 

 

Highlighting a Range 

A range may be designated by highlighting a group of rows. To create a selection 
range, hold down the left mouse button and drag the mouse to highlight the range area. 
When a range or group is selected it will be highlighted in reverse video.  Once a range 
or group is highlighted the user may click on the Convert button to generate orders. 
Only those securities within a specified range will be converted into orders.  This allows 
a trader to convert a partial list or to convert the list in sections. 

Setting Accounts 

Setting Accounts by Cell 

 
When accounts are listed horizontally or, side by side, they must be set by cell. 

 
1. Place the cursor on the cell containing the account name to be set.  Highlight that 

cell. 
2. If more than one cell is to be highlighted and they are adjacent, drag the mouse 

across to highlight each account cell. 
3. If more than one cell is to be highlighted and they are not adjacent, hold down the 

control key, while you relocate the mouse and highlight each additional cell. 
4. When all the cells are highlighted, click on the Set Sub Acct button. 
5. Click on the Convert button. 

 

Setting Accounts by Column 

 
When account names are listed vertically in a column, they must be set by column. 

 
1. Click on the header of the column to be set. 
2. Click on the Set Sub-Account button. 
3. Click on the Convert button. 
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Setting Accounts by Range 

 
When accounts are grouped by range (account headings followed by a group of 
securities in that account), each row or cell containing an account heading must be 
highlighted, set, and converted. 

 
1. Place the cursor over the status column, and click on the row containing the account 

name. This will highlight the entire row. 
2. To highlight, set, and convert multiple rows of accounts, hold down the control key on 

the keyboard while you continue this procedure until all accounts have been 
highlighted. 

3. Let go the control key and click the Set Sub Acct button. 
4. Click on the Convert button.  

Setting Attributes 

Setting Attribute Cells 

What it does: 

• Setting a cell identifies the data in that cell. 

• Setting an attribute guarantees that the data will not be confused with other data 
similar in character. 

 
Example:   Many lists contain columns of three character data which could match account names, 
country codes, tickers, sides, etc.  TIE will generate conflicts when there is ambiguous data.  
Setting data resolves conflicts quickly. 

To Set a cell: 

1. Highlight the cell to be set. 
2. Click the desired “Set” button (i.e.: Set Ticker, Set Sub-Account, Set Sedol). 
3. Click the Convert button. 

 
Once a column has been set, an asterisk will appear in the column header. 

Re-Setting a Cell: 

Data that was previously set must be re-set and converted once it has been edited.  This 
allows the new data to be interpreted and the appropriate output folders and reports to be 
updated accordingly.  

 

Setting Attribute Columns 

What it does: 

• Setting a column gives precedence to that column. 
 

Example:   If there is a ticker/sedol conflict and the user sets the sedol column, TIE will convert the 
trade using the sedol.  

 

• Setting a column guarantees that the data in that column will not be confused with 
any other data similar in character. 

 
Example:   Many lists contain columns of three character data, which could match account names, 
country codes, tickers, sides, etc.  TIE will generate conflicts when there is ambiguous data.  
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Setting or cutting a column ahead of time cuts down on the number of possible conflicts a trader 
will have to resolve. 

 

To Set a column: 

1. Select a column by clicking on its header.  This will highlight the column. 
2. Click the appropriate “Set” button (i.e.: Set Ticker, Set Sub-Account, Set Sedol). 
3. Click the Convert button. 

 
Once a column has been set, an asterisk will appear following the word in the column 
header. 

Re-Setting a column: 

Making changes to data in a column that has already been set, requires that the column 
be re-set and converted.  This processes the new data and updates the output folders 
and reports accordingly.  

 

Setting Attribute Ranges 

What it does: 

• Setting a range gives precedence to attribute data in that range. 

• Setting an attribute guarantees that the data will not be confused with any other data 
similar in character. 

 
Example:   Many lists contain columns of three character data which can match account names, 
country codes, tickers, sides, etc.  TIE will generate conflicts when there is ambiguous data.  
Setting data resolves conflicts quickly. 

 

Setting a range: 

1. Select a range by highlighting the cells to be set. 
2. To select or highlight the cells, hold down the mouse’s left-click button and drag the 

mouse over the selection of cells. 
3. Click the desired “Set” button (i.e.: Set Ticker, Set Sub-Account, Set Sedol). 
4. Click the Convert button. 

 
Once a column has been set, an asterisk will appear in the column header, when the 
column is wide enough for it to be displayed. 

Re-Setting a range: 

Any data that was previously set must be re-set and converted once it has been edited.  
This allows the new data to be interpreted and the appropriate output folders and reports 
to be updated accordingly.  
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Side Processing 

Advanced Features 

TIE™ prompts the user to set the side manually unless the user selects to have TIE™ 
deduce the side from the sign of the shares.  To have TIE™ deduce the side, go to the 
Tools menu and select Advanced Features.  Place a check in the check box beside 
"Deduce the Side from Sign of Shares" in the Advanced Features dialog box. 

 

Precedence 

TIE™ gives precedence to synonyms over the sign of the shares when both appear in a 
list.  For example, if a list says "Short Sale" at the top of the page and all the shares 
have minus signs in front of them, TIE™ will convert the shares as Sell Shorts.  If the 
words "Short Sale" are deleted, and only the minus signs remain, TIE™ will convert the 
list as "Sells". 
 

Side Synonyms 

TIE™ recognizes 54 side synonyms including foreign words and the Japanese Symbols 
for "buy" and "sell".  The synonyms in TIE™'s database can be viewed in the Side 
Reference dialog box, where additional synonyms can be temporarily added. 
 
If side abbreviations are listed for each row in a trade list, the side column can be set so 
that the abbreviations won't cause ambiguity conflicts with tickers and other data. 
 

Side Radio Buttons 

The Side Radio Buttons are located on the Control Panel to the right of the TIE™ 
screen. 

 
 
The side for an entire order can be changed by clicking on one of the Side Radio 
Buttons, and then clicking on the Convert button. This feature saves time by eliminating 
the tedious process of having to edit the side in every row.  Side changes are instantly 
updated in the Summary Grid located on the Control Panel and in all related output 
folders and reports.   
 
A portion of a list may also be changed by highlighting a range of rows or specifying row 
numbers in the Range edit controls.  Please note that only the securities within the 
specified range will be converted into orders. 



Trade Import Expert�   Chapter 3: Conversion Procedures 

Software Intelligence, Inc. © 2001 20

 

Side by Range 

When a list contains side synonyms as section headers, rather than for every row, 
TIE™'s side by range processing interprets them as the side assigned to all orders 
following the synonym. 
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4.  EDITING PROCEDURES 

Aligning Data 

To align data:  

1. Select a column by clicking on its header. 
2. Hold down the Control key on the keyboard and click the right mouse button to shift the 

alignment of the data from left justified to right justified, or visa-versa.  
  
Note:  This feature is only supported in the Tabular and Unknown folders. 

Bisecting Columns 

To bisect a column:  

1. Place the cursor in the header row of the column to be bisected.  Position the cursor 
on the right field delimiter of that column (or the right edge of the screen when no 
columns are present), until the cursor arrow becomes a line with a double-pointed 
arrow crossing through it. 

2. Simultaneously hold down the Control key and press the left click button on the mouse.  
Drag the field delimiter to the left.   

3. When you have positioned the field delimiter, release the left click button on the 
mouse.   

 
Note:  During bisect and merge operations the column’s new width is displayed in character units 
in its header region. This feature is only supported in the Tabular and Unknown folders. 

Copying and Pasting 

Copying Function 

There are three ways to copy a highlighted selection of data: 1) click on the Copy 
button, 2) right click on the mouse and select “copy” from the pop-up menu, or 3) hold 
down the Control key on the keyboard and type the letter ”C”.  TIE™ supports each of 
these methods. 

Copying and Pasting Data 

TIE™ allows the user to copy data, such as a sedol, from the screen and paste it into a 
reference dialog box edit control, another location on the screen, or a text document 
outside of TIE™.  Data can also be copied from reference dialog box edit controls, and 
pasted into a list in the Tabular or Excel folders, or a text document outside of TIE™.   
 

Note: A large string of data, or data occupying more than one will be considered by TIE™ to be 
a new trade list.  Pasting it into TIE™ will clear the screen, insert the pasted data, and bring up 
the Set Client Dialog Box. 

Copying a List and Pasting it into TIE™ 

The user can copy a list from a text or Excel™ file, click anywhere on the TIE™ screen 
and paste in the list.  TIE™ will automatically clear any data on the screen, input the 
new information and bring up the Set Client Dialog Box. 
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Editing in the Various Folders 

Editing in the Bid Folder 

Editing in the Bid folder is not supported. 

Editing in the Country Folder 

Editing in the Country folder is not supported.  The Country folder is comprised of 
summary data. This data is automatically updated when changes are made to prices, 
number of securities, share quantities, sides, or countries in any of the other output 
folders.  Revisions to accounts can only be made in the Tabular folder.  Revisions made 
in the Tabular folder are updated to the Country folder when the Convert button is 
clicked. 

Editing in the Daily Folder 

Editing in is not supported in the Daily folder. The Daily folder is a running log of all 
orders uploaded to the trading system on any given day. 

Editing in the Excel™ Folder 

The Excel™ folder provides editing capabilities at the cell, row, column or range level.  
Editing of individual cells is done in the cell rather than in a formula bar.  Cut and delete 
operations are available on ranges of rows and columns. 

Adding and deleting columns and Formatting data 

Double clicking the Right Mouse Button over the Excel™ grid in the Excel™ folder 
brings up the Tidestone Formula Once Workbook Designer™ which offers the 
standard suite of Excel™ editing and formatting tools. 
 
Once the order is entered, click on the Convert button to process the data; the Set 
Client dialog box will appear.  Once the client is set, check the Tabular folder for 
order status and error screening. 

Cutting and Deleting 

To cut or delete a row or column, simply highlight it and click on the Cut button or 
the press the delete key on the keyboard.  Cutting will remove the entire row, where 
deleting will remove the data from the row. 

Cutting or Deleting More Than One Row at a time 

The Excel™ folder supports cut and delete operations on ranges of rows.  To cut or 
delete a range of rows, create a selection range.  To create a selection range, hold 
down the left mouse button and drag the mouse to highlight the range area.  To 
group non-consecutive rows hold down the control key and select rows by clicking 
the left mouse button on each row.  When a range or group is selected it will be 
highlighted in reverse video.  Once a range or group is highlighted the user may cut 
the rows using the Cut button on the toolbar or press the delete key on the keyboard 
to remove just the data. 
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Manually Entering Orders 

Entering the Order 
Orders can be entered manually in the Excel™ folder.  Click on a sell, type in the data 
and tab or mouse to the next cell and continue.   
Formatting the List 
Double clicking the Right Mouse Button over the Excel™ grid in the Excel™ folder 
brings up the Tidestone Formula Once Workbook Designer™ which offers the standard 
suite of Excel™ editing and formatting tools. 
Converting the Order 
Once the order is entered, click on the Convert button to process the data; the Set 
Client dialog box will appear.  Once the client is set, check the Tabular folder for order 
status and error screening. 
Saving the List 
In TIE's Excel™ folder, Double-Click Right on the Mouse to bring up the Tidestone 
Workbook Designer™.  Click on the Workbook Designer "Save" button.  Make sure to 
specify the file type (e.g. Excel™ 97). 

Processing the Editing Changes 

To process editing changes made in the Excel™ folder or to enter a manual order into 
the Tabular folder, click on the Convert button in the toolbar.  This will display the 
changes or new order in the Tabular folder. 

Widening Columns 

Columns may be widened to accommodate larger data by clicking on the right field 
delimiter in the column header and dragging it to the right. 

Editing in the Input Folder 

Editing in the Input folder is not supported.  The Input folder contains raw data and 
provides the trader with an unmodified original list for the purpose of cross-referencing.  
The data in this folder remains unchanged regardless of what editing is done to the 
order in other folders. 

Editing in the Report Folders 

The copy feature is the only editing feature supported, allowing a user to copy report 
data for pasting into other documents. 

Editing in the Tabular Folder 

TIE™’s Tabular folder provides versatile editing capabilities.  The Tabular folder allows 
editing at the cell, row, column, and range levels.  The Tabular folder supports the 
following operations: edit, cut, copy, paste, delete, sort, align right/left, bisect, merge, 
and transpose. 

Aligning Data  

To align the data in a column, select the column by clicking on its header. Hold down 
the Control key on the keyboard and click the right mouse button to shift the alignment 
from left justified to right justified or visa-versa. CTRL + right click. 

Bisecting Columns 

To bisect a column, place the cursor in the header row of the column to be bisected.  
Position the cursor on the right field delimiter (or the right edge of the screen when no 
columns are present), until the cursor arrow becomes a line with a double-pointed arrow 
crossing through it.  Keeping the cursor there, hold down the control key while pressing 
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the left click button on the mouse and drag the field delimiter to the left.  When you have 
positioned the field delimiter, release the left click button on the mouse.  Position 
cursor, CTRL + left click, drag left. 

Copying  

The Tabular folder supports copying a highlighted selection of data onto the clipboard 
for pasting into a fresh TIE™ grid.  Another useful feature is that the trader can copy 
data from a reference dialog box and insert it into a cell or row in the TIE™ grid.  This 
enables quick editing of sedols, tickers, account names, etc.  The reverse can also be 
done, for example, the user can copy a sedol from the grid and paste it into the sedol 
edit control in the Security Reference dialog box, to search for that security.  This saves 
time and prevents potential typos that can occur manually. 
 
To copy data, highlight the cell, row, or range to be copied and click on the Copy button 
on the toolbar or press CTRL + C. 

Cutting and Deleting a Row 

To cut or delete a row, simply highlight it and click on the Cut button or the press the 
delete key on the keyboard.  Cutting will remove the entire row, where deleting will 
remove the data from the row.   

Cutting or Deleting More Than One Row at a time 

To cut or delete a range of rows, create a selection range.  To create a selection range, 
hold down the left mouse button and drag the mouse to highlight the range area.  To 
group non-consecutive rows hold down the control key and select rows by clicking the 
left mouse button on each row.  When a range or group is selected it will be highlighted 
in reverse video.  Once a range or group is highlighted the user may cut the rows using 
the Cut button on the toolbar or press the delete key on the keyboard to remove just the 
data. 

Merging Columns 

To merge two columns, place the cursor in the header row, on the field delimiter 
between the two columns to be merged.  Adjust the mouse position until the cursor 
arrow becomes a line with a double-pointed arrow crossing through it.  Keeping the 
cursor there, hold down the control key on your keyboard while you press the left click 
button on your mouse and drag the field delimiter to the right.  When you have 
positioned the field delimiter, release the left click button on the mouse. Position 
cursor, CTRL + left click, drag right. 

Pasting 

Inputting a Trade List 
The Tabular folder supports pasting data on the clipboard into the TIE™ grid.  The user 
can paste data from almost any kind of document into TRADE IMPORT EXPERT™ for 
conversion.   
 
Making Editing Changes 
The user can paste data copied from one of the reference dialog boxes into a cell in the 
TIE™ grid.  This enables quick editing of sedols, tickers, account names, etc., and 
prevents potential typos that can occur manually. 
 .   
Looking Up Reference Data 
The user can copy data from the TIE™ grid and paste it into an edit control of a 
reference dialog box to search for the data.  This saves time and prevents potential 
typos that can occur manually. 
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Looking Up Reference Data 
The user can copy data from the TIE™ grid and paste it into an edit control of a 
reference dialog box to search for the data.  This saves time and prevents potential 
typos that can occur manually. 
 
To Paste Data 
To paste individual data, place the cursor where the data is to be located.  Highlight the 
cell or row, and click on the Paste button on the toolbar, press Ctrl + V, or select 
"Paste" from the right click mouse menu.   
 
To paste a file or large grouping of data into the grid place the mouse anywhere on the 
TIE screen and click on the Paste button on the toolbar, press Ctrl + V or select "Paste" 
from the right click mouse menu. 
 
Note:  Pasting more than one row of data into TIE™ clears the screen and inserts the data from 
the clipboard as a new trade list. 

Ranges 

Ranges may be specified by using the Range edit controls located in the Control Panel 
to the right of the TIE™ grid.  A range may also be designated by highlighting a group 
of rows. To create a selection range, hold down the left mouse button and drag the 
mouse to highlight the range area. When a range is selected it will be highlighted in 
reverse video.  Once a range is highlighted the user may click on the Convert button to 
generate orders.  
 
Only those securities within a specified range will be converted into orders.  This allows 
a trader to convert list in sections if needed, or to convert only a partial list if required. 

Side Radio Buttons 

The Side Radio Buttons are located on the Control Panel to the right of the TIE™ 
screen. 
 
The side for an entire order can be changed by clicking on one of the Side Radio 
Buttons, and then clicking on the Convert button. This feature saves time by eliminating 
the tedious process of having to edit the side in every row.  Side changes are instantly 
updated in the Summary Grid located on the Control Panel and in all related output 
folders and reports.   
 
A portion of a list may also be changed by highlighting a range of rows or specifying row 
numbers in the Range edit controls.  Please note that only the securities within the 
specified range will be converted into orders. 

Sorting a List 

To sort a list, select the column containing the sort criteria by clicking on its column 
header.  Hold down the Control key on the keyboard and double click the left mouse 
button.  Double clicking a second time will reverse the sort order.  CTRL + left double-
click. 
 
Note: Please note that every row in a list will be sorted.  If internal headings are included in the 
trade list, sorting may possibly do away with helpful input organization. 

Transpose 

To transpose data in a list where the upper and lower case letters need to be reversed, 
click on the column header to highlight the column, then hold down the Shift key and left 
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double click. (Example: RICs are sometimes sent with the upper and lower case letters 
in reverse.)   
Shift + left double click. 

Editing in the Total and side folders 

Editing in the Total and "side" folders, also known as the Output folders, can be done 
on most attributes. 

Sorting 

The list may be sorted by any data category simply by holding down the control key and 
double clicking on the column header.  This feature makes locating specific securities 
fast and easy.  Securities can be grouped by side or alphabetically by ticker, RIC, or 
company name.  They can be grouped according to share quantity or even by 
comments. The sort feature adds flexibility to Total and side folders for cross-
referencing, editing and proof reading. Sorting in the output folders will not affect any 
output or upload results. CTRL + left double-click. 

Column Width 

The column width can be adjusted in all the output folders, making if possible to display 
numbers, names, or memos, etc. that extend beyond the standard column width.  To 
adjust column width, place the mouse on a field delimiter in the column header area.  
When the cursor becomes a line with a double arrow crossing through it, click left on 
the mouse and drag the field delimiter to the appropriate width.  Position cursor, left 
click and drag. 

Sides 

Editing the side changes the color of the row to correspond with the color of the new 
side. Simultaneously, that order becomes viewable in the specific side output folder. 
Side changes are instantly updated in the Summary Grid located on the Control Panel 
and in the related output folders and reports. 

Identifiers 

Editing an identifier (ticker, RIC, cusip, sedol, etc.) so that it represents a different 
security instantly updates the other identifiers in the row, along with the company name, 
country, closing price and principals. The output folders, reports, and Summary Grid are 
also instantly updated.   

Shares 

Share quantities may be edited when there are no sub-accounts.  When a share 
quantity is edited, related principals and share totals are instantly recalculated and the 
output folders, reports, and the Summary Grid are simultaneously updated.   
 
When there are sub-accounts, the share quantities and allocations must be edited in 
the Tabular folder, and the order reconverted.  Attempts to edit allocation shares in the 
output folders will result in a warning message and any typing will revert to the original 
data. 

Prices 

Local and USD prices may be edited in the Total and side folders.  Editing one will 
update the other.  TIE™ recalculates all principals using exchange rates where 
required, and instantly updates the output folders, reports and Summary Grid. 
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Country 

The country may only be edited for securities that are dually listed.  TIE™ restricts the 
country editing to these cases only.  

Company name 

The company field cannot be edited. The company name is displayed exactly as it 
appears in the database.   

Industry 

The industry field cannot be edited. 

Principals 

Principals cannot be edited. Changes must be made to the prices or share quantities in 
order to be reflected in the principals. Attempts to edit principals will result in the data 
reverting back to the original data when the user exits the cell. 

Exchange, Destination and Restriction 

These may be edited in the security rows but not in the allocation rows. 

Memos and Comments 

The Memo and Comments fields cannot be edited.   
 
Note:  The Memo column displays information from the Tabular folder which can be edited and 
reset in the Tabular folder.   

Editing in the Unknown folder 

Data in the Unknown folder may be edited at the cell, row, column or range level.  The 
Unknown folder supports the following operations: edit, align left or right, cut, paste, 
delete, bisect, and merge.  
  
Corrections made in the Unknown folder can be applied incrementally to the converted 
list.  To apply the corrections, click on the Convert button.  Orders recognized from the 
resulting corrections will be inserted in the trade list and removed from the Unknown 
folder. 
 
To display expanded error messages for a row, click on the row.  The error messages 
will appear on the application status bar. 
 
Note: Editing and converting while in the Unknown folder will produce corrections in the output 
and report folders.  Those corrections will not appear in the Tabular folder, which is an input 
folder. Reconverting from Tabular converts the original input, overriding (losing) any changes 
made in the Unknown folder.  If the user plans on making additional editing changes in Tabular, 
then all corrections should be made in the Tabular folder.  
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FastFind 

TIE™ can instantly conduct searches for data in the Tabular, Unknown, Total, and side 
folders. (i.e.: ticker, RIC, sedol, side, account, country, company name, etc.) Shift + 
Right Click 

To search for data: 

1. Position the cursor over the cell. 
2. Hold down the shift key and click the right mouse button. 

TIE™ will bring up the appropriate reference dialog box with completed results of the 
search, and display the search results in the Status Bar at the bottom of the screen. 

Entering an Order Manually 

Entering an Order 

Orders can be entered manually in the Excel™ folder.  Click on a sell, type in the data 
and tab or mouse to the next cell and continue.   
 

Formatting the Order Entry 

Double clicking the Right Mouse Button over the Excel™ grid in the Excel™ folder 
brings up the Tidestone Formula Once Workbook Designer™ which offers the standard 
suite of Excel™ editing and formatting tools. 
 

Converting the Order 

Once the order is entered, click on the Convert button to process the data; the Set 
Client dialog box will appear.  Once the client is set, check the Tabular folder for order 
status and error screening. 
 

Saving a Manually Entered Order as a File 

In TIE's Excel™ folder, Double-Click Right on the Mouse to bring up the Tidestone 
Workbook Designer™.  Click on the Workbook Designer "Save" button.  Make sure to 
specify the file type (e.g. Excel™ 97). 
 

Merging Columns 

To Merge Columns:  

1. Place your cursor in the header row on the field delimiter between the two columns to 
be merged.  Adjust the mouse position until the cursor arrow becomes a line with a 
double arrow crossing through it. 

2. Hold down the control key, then press the left click button on the mouse and drag the 
field delimiter to the right.   

3. When you have positioned the field delimiter, release the left click button.  
 

Note:  During bisect and merge operations the column’s new width is displayed in character 
units in its header region. This feature is only supported in the Tabular and Unknown folders. 
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Moving Field Delimiters 

To Move or Drag a Field Delimiter: 

1. Place your cursor over any field delimiter in the header row of the grid.  The cursor will 
display a line with a double arrow running through it. 

2. Hold down the control key, and press the left click button on the mouse.  
3. While holding these down simultaneously, drag the mouse/field delimiter left or right. 

 

• Dragging a delimiter to the left and releasing will bisect a column by adding a new 
delimiter.   

• Dragging a delimiter to the right and releasing will merge columns. 
 
Note: If columns have been set, they will have to be reset after any field delimiter has been 
moved. This feature is only supported in the Tabular folder. 

Sorting Data 

To sort a list: 

1. Select the column containing the data the list will be sorted by and click on its column 
header.   

2. Hold down the Control key on the keyboard and double click the left mouse button.   
3. Double clicking a second time will reverse the sort order.   

 
Note:  Every row in a list will be sorted.  If internal headings are included in the trade list, sorting 
may possibly do away with helpful input organization. 
 

This feature is supported in the Tabular folder and all output folders with the exception of the 
Unknown folder. 

Transposing upper & lower case letters 

To Transpose 

1. Select the data (the cell or column) to transpose by highlighting it. 
2. Hold down the Shift key and double-click on the left mouse button. 

Shift + Left Double Click 



Trade Import Expert�   Chapter 5: Upload Procedures 

Software Intelligence, Inc. © 2001 30

5.  UPLOAD PROCEDURES 
Upload procedures will vary from client to client as these are customized to integrate 
with each firm's specific systems and according to their requirements. 
 
Files may be saved to a directory, as a FIX message, emailed to a client, or uploaded to 
various execution systems. 
 
For more detailed information regarding your company's specific upload procedures, 
request a customized Users Guide from Software Intelligence, Inc. or email 
sales@softintel.com. 
 

Standard Upload Procedures 

Typically one or more save/upload button will appear on  TIE™'s toolbar.  Each upload 
button brings up a dialog box for that execution system.  Below are the instructions for 
some standard features that may be included in the upload dialog boxes. 

Selecting Security Identifier  

The security identifier is selected by scrolling through the list box and double clicking on 
the selection.  This determines the identifier that will be used for the upload.  If no 
identifier is selected, TIE™ defaults to the identifier the client sent. 

Selecting the Client Name 

When the client has already been set using the Set Client dialog box, the client name 
will be pre-selected in the Trade Execution System upload dialog box.  If the client 
name edit control is left blank a warning will appear, the dialog box will close, and the 
user will have to click on the upload button to begin the process again. 

Selecting USA or CAN for Dually Listed USA/CAN securities in the list 

When a list contains securities that trade both in US and Canada, two radio buttons will 
appear in the upper right corner of the dialog box.  These determine whether dually 
listed securities are to be uploaded as Canadian or US. To select a radio button, click 
the mouse on it, so that a black circle appears in the center.  If no selection is made, 
TIE™ will default to the country displayed in the Total folder.  (Please note that the 
country column in the Total folder can be edited to change the country for individual 
dually listed securities.) 

Selecting UKM or IRE for Dually Listed IRE/UKM securities in the list  

When a list contains Irish securities that trade on the London exchange, two radio 
buttons appear in the upper right corner of the dialog box.  When the UKM radio button 
is selected, orders will be uploaded with UKM as the country.  When the IRE radio 
button is selected, orders will be uploaded with IRE as the country. To select a radio 
button, click the mouse on it, so that a black circle appears in the center.  If neither 
button is selected, TIE™ will default to the country displayed in the Total folder.  
(Please note that the country column in the Total folder may be edited to change the 
country for individual securities.) 

Aggregating Allocations 

TIE™ gives the user the option of aggregating allocations in the upload, or uploading 
them individually. TIE™’s default mode is to aggregate allocations in the upload. 

mailto:sales@softintel.com
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Optional Updating of the Daily Summary Report 

Test files can be uploaded without being added to the Daily Summary Report.  A check 
is provided for this option.  The box has a default check in it to add the upload to the 
Daily Summary Report. 

Saved Output Files 

A copy of TIE™’s output file is automatically saved to the user’s directory each time an 
order is uploaded to the Trade Execution System.   
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6.  FEATURES 

Account Reference 

The Account Reference dialog box allows the user to look up all the accounts for a 
particular client, to look up specific account names, and to add, delete and update 
account information. 
 
Click on the button marked, ACCT REF or select Account Reference in the right-click 
pop-up menu. 
 

 

Adjust Font Display Resolution 

The Adjust Font Display Resolution feature allows users to adjust the display resolution 
on systems in large font mode.  If Trade Import Expert™ cannot display its entire 
window when it first starts, the Windows™ NT driver is probably in large font mode.  
When this occurs the grid is visible but the control panel is not. A simple click of the 
large/small font button “B/b” on the tool bar will adjust for screen font problems.  

Advanced Features 

Advanced Features can be found in the Tools Menu located on TIE™'s Menu Bar.  The 
Advanced Features dialog box contains check-boxes allowing the user the option of 1) 
having TIE™ deduce the side of a list based on the sign of the shares, 2) having TIE™ 
prompt the user when Canadian securities are present in a list, and 3) having TIE™ 
choose the Canadian securities when identifiers in a list are dually listed. 
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Alert Lights 

Trade Import Expert™ warns the trader, through a series of alert lights, if there are 
problems with any of the security data in a trade list. 
 
TIE™ generates alerts for four different situations: 

• Unknown security identifiers 

• Conflicts between security identifiers 

• Prices out of range   

• Allocation imbalances 
    

A green LED indicates no conflict.  A gray LED means that the alert is not applicable.  A 
red LED indicates a conflict.   
 

 
 

• The Security Alert lets the user know if there are unknown security identifiers in a 
list. 

 

• The Conflict Alert lets the user know if there are securities in a list that have not 
been converted into orders due to data conflicts. 

 

• The Price Alert indicates whether the prices given in a list are +/- 5% over or under 
the prior night’s closing price.  

 

• The Allocation Alert indicates any sub-account allocation imbalances, and will only 
be lit when sub-accounts are present in a list. 

Related Summaries, Error Messages and Reports:   

�� Counts of the conflicts and alerts are displayed in the last row of the Summary 
Grid.  

�� Messages describing the conflicts are displayed in the Status Column of the 
Tabular folder and in the Status Bar at the bottom of the screen when an individual 
row is highlighted.   

�� When prices are out of range, the % the price is off will be displayed in the 
Comments field of the output folders.   

�� Complete lists of conflicts and errors can be found in the Report and the Errors 
output folders. 
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Bid Report 

TIE™ generates a bid sheet for each converted trade list. TIE™ calculates the 
commission, tax, clearing costs, and basis points for aggregate shares broken down by 
country and side. 

 
 

Canadian and Dually Listed Processing 

TIE™ has a variety of options for handling dually listed securities. TIE™ will default to 
the US ticker unless the Canadian security is specified by a unique security identifier 
(i.e. RIC).  TIE™ will default to the UK security unless the Irish security has been 
specified. 

Reporting of Dually Listed Securities 

1. The Status Bar of the Tabular folder will display "Dually Listed" at the beginning of 
the security summary, when applicable. Click on an individual security row to view 
the security summary in the Status Bar.   

2. Dually listed securities are noted in the Comments field of the Total and side folders. 
3. Dually listed securities are reported in the Dually Listed Securities section of the 

Trade Summary Report. 

Alerting the user of Canadian securities and/or dually listed securities in a list 

TIE™ provides the user the option of being alerted when a Canadian security appears 
in a list.  From the Tools Menu select Advanced Features. Placing a check in the 
“Prompt User for Canadian Securities” check-box enables a prompt that will come up 
each time a user drags in or converts an order. 
 
Note:  Once the Canadian Prompt is checked it will remain on when opening up new grid sheets.  
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Changing the security selection of a Dually Listed Security 

Changing individual securities 

If a user wants to change the country of an individual security, this can be done in the 
Total and side folders by editing the Country cell for that security. 
 
Once edited, tabbing out of the cell will reconvert the dually listed security’s data to 
correspond with the country selected. 
Note: TIE™ will only allow editing of the country column when a security is dually listed, and will 
only allow the USA or CAN country abbreviations. 

Changing the security selection for an entire list 

If the user wants TIE™ to select the Canadian security each time a dually listed security 
appears in a list, TIE™ provides a check-box to “Choose Canadian when Dually listed”. 
This check box is located in the Advanced Features dialog box under the Tools menu. 
 
Note: The check box will remain checked or unchecked according to the user’s last setting when 
a new file is dragged in over a previous file, but the check box defaults to unchecked (choosing 
US securities when dually listed) each time a new grid sheet is opened. 

Changing the security selection in an entire list when uploading to the Trade 
Execution System  

When Canadian and/or dually listed securities are present in a list, TIE™'s Trade 
Execution System Upload dialog box will include radio buttons that allow the user to 
upload securities as UKM, IRE, CAN, or USA (depending upon what is in the list). TIE™ 
defaults to the country displayed in the Total folder when no radio button is selected. 

Clear 

The Clear button clears the active TIE™ grid and all corresponding folders, except the 
Daily folder. 
 
Note: Other grids containing lists will remain intact and may be accessed by clicking on the 
Window menu in the toolbar and selecting a display type or an individual file name. 

Clear Refresh Timer 

Trade Import Expert™ has an automated Refresh Timer that refreshes reference data 
daily at 7am local time. Trade lists open in TIE™ at that time are closed automatically, 
and the data TIE™ is drawing from is updated. This gives the user access to updated 
reference data, including changes in tickers, prices, restricteds, foreign exchange rates, 
etc. 
 
The Refresh Timer is a feature that is pre-enabled. If the user chooses not to have the 
reference data updated automatically at the pre-set hour, it can be disabled by selecting 
Clear Refresh Timer from the Tools menu at the top of the screen.  Once it has been 
disabled, it will no longer refresh each morning until it is set again. 
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Client Reference 

The Client Reference dialog box allows the user to search for, verify, add, and delete 
client names and IDs. 
 
The Client Reference dialog box has a scrolling list box for the Client ID and an edit 
control for the Client Name. 
 
Click on the button marked, CLIENT REF or highlight and click on Client Reference in 
the right-click pop-up menu. 
 

 

Converting Lists Simultaneously 

Trade Import Expert™ allows multiple lists to be converted simultaneously.  To process 
multiple lists simultaneously, create multiple TIE™ grids by clicking on the New button 
on the toolbar.  Each new grid has a unique name that is displayed on its window’s 
header bar.  Once a file has been opened or dragged into the grid, the header bar will 
display the file name and a client name.  The various windows may be viewed and 
accessed by clicking on the Window menu in the toolbar and selecting a display type or 
an individual file name. 

Copy 

The Copy button allows the user to copy a highlighted selection of data onto the 
clipboard for pasting into the TIE™ grid or into another editable document or grid such 
as Microsoft Word™ or Excel™.  A trader can also copy data from one of the reference 
dialog boxes and insert it into a cell or row in the TIE™ grid.  This enables quick editing 
of sedols, tickers, account names, etc.  The reverse can also be done, for example, a 
user can copy a sedol from the grid and paste it into the sedol edit control in the 
Security Reference dialog box, to search for that security.  This saves time and 
prevents potential typos that can occur manually. Traders can also copy a converted list 
from the Total folder and paste them into Microsoft Excel™ to run analytics. 

Country Reference 

The Country Reference dialog box allows the user to search for, verify, add, and delete 
country abbreviations.   
 
To access the Country Reference, click on the button marked, CTRY REF, or highlight 
and click on Country Reference in the right-click pop-up menu. 
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The Country Reference includes a scrolling list box of country abbreviations and edit 
controls for the country abbreviation and the country name ("description"), region, 
commission rate, buy tax rate, sell tax rate, and clearing fees. 
 
The data displayed in the Country Reference is the data used to compute transaction 
fees in the Bid folder. 
 

 

Cut 

Clicking on the Cut button or holding down the Control key while pressing “C” on the 
keyboard will permanently remove the highlighted column(s) or any column(s) 
containing highlighted data.  The cut feature works in the Tabular folder, Unknown 
folder, Excel folder, and all output folders. 

Daily Summary Report 

The Daily folder provides a daily summary report of all trade lists uploaded into the 
trading system.  The Daily Summary Report includes the time the trade list was 
uploaded, the client, type and strategy of the trade, the region (domestic or 
international), the total number of buy shares, sell shares, and aggregate shares, the 
buy principal, sell principal, net principal, and total principal.  Grand totals of these 
numbers are given at the bottom of the summary and updated each time a new order is 
uploaded.   
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Data Refresh 

Trade Import Expert™ offers a data refresh option.  This gives the user access to the 
most up to date reference data, including changes in tickers, prices, restricteds, foreign 
exchange rates, etc. 
 
By selecting Refresh Reference Data from the Tools menu at the top of the screen, all 
lists currently open in TIE™ will be closed automatically, and the data TIE™ is drawing 
from will be updated.  The user also has the option of selecting Set Refresh Timer so 
that the data will be refreshed at a pre-set time.  The pre-set Refresh time is 7am, local 
time.  A Clear Refresh Timer option is also available, if a user decides not to have the 
reference data updated automatically at the pre-set hour. 

Display Allocation Detail 

Trade Import Expert™ processes sub-account allocations for orders, when sub-
accounts have been recognized or “set” during order conversion.  The Total folder and 
side output folders share a feature that displays the allocation detail for each order.  To 
view the order/allocation detail, click on the button marked, SUB ACCT on the tool bar. 
Allocation rows are displayed in italic font beneath the order row. An allocation row 
contains the following attributes: ticker, allocation share quantity, client mnemonic, 
account mnemonic, account number, and the allocation’s principal. 
 
The allocation detail can be toggled on or off by clicking the SUB ACCT detail button on 
the toolbar.  If an order contains no sub-accounts or no accounts have been set, 
clicking the button will have no effect. 
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Editing 

Input data may be edited in the Excel™, and Tabular folders.  Processed data may be 
edited in the Unknown, Total, and Side output folders.  The editing features available 
depend upon which tabbed folder is selected.  The Excel and Tabular folders provide 
the most flexibility. Folders that do not allow editing include: the Input folder, which 
displays original text file data, and the Country folder and report folders, which are 
comprised of summary data. 

Error Reporting 

Trade Import Expert™ gives the trader feedback on errors in a trade list through a 
variety of features.  These include: Alert Lights, Reconciliation Lights, the Summary 
Grid, Status Column, Status Bar, the Total folder Comments field, the Trade Summary, 
Errors, Mismatch, Odd Lot, Price, and Restricted reports. 
 
Counts of the conflicts and alerts are displayed in the last row of the Summary Grid.  
Messages describing the order status (conflicts, errors, potential problems) are 
displayed in the Status Column of the Tabular folder and in the Status Bar at the bottom 
of the screen when an individual row is highlighted.   
 
When prices are out of range, the % the price is off will be displayed in the Comments 
field of the output folders.  Closing prices that are zero (missing from the data base) will 
be listed in the Trade Summary and the Price reports. Odd lot share quantities are 
displayed in the Status Bar at the bottom of the Tabular screen when an individual row 
is highlighted, and are noted in the Comments field of the Total and side output folders.   
 
Complete lists of conflicts, errors, mismatches, odd lots, restricteds, zero prices and 
prices out of range can be found in the Report, Errors, Mismatch, Odd Lot, Restricted 
and Price report folders. 
 
The Trade Summary Report displays the TIE™ kick outs and the Trade Execution 
System kick outs after a file has been uploaded. 

European Attributes 

Trade Import Expert™ has the ability to recognize, convert lists, and upload by 
European attributes when European Attributes is enabled.  This feature is turned on or 
off in the Registry.  When it is enabled a special European Attributes toolbar will be 
added to the current toolbar. TIE™ can upload trade lists by Sicovam, Valoren, 
Kassenverein, ISIN, and A client’s internal security symbol, in addition to Ticker, Quick 
Code, Cusip, RIC, and Sedol. 

FastFind 

Trade Import Expert™ provides intelligent search capabilities.  In the Tabular, 
Unknown, Total and "side" folders, users can instantly search for data by pressing the 
shift key on the keyboard and double-clicking the right mouse button on a cell.  TIE™ 
instantly conducts a search for the data (i.e.: ticker, ric, sedol, side, account, country, 
company name, etc.) 
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Finance Charge 

A user may include or exclude finance charges from the Bid Report by selecting a check box 
from TIE™'s menu: Tools > Advanced Features > Include Finance Charge.  A calendar for 
selecting the settlement date is opened from TIE™'s menu: Tools > Set Finance Date. 

 

Foreign Exchange Reference 

The Foreign Exchange Reference (FX) dialog box allows the user to search for, 
confirm, or revise exchange rates for foreign currencies.  
 
The Foreign Exchange Reference includes a scrolling list box of currency codes, and 
four edit controls, which display the currency abbreviation, the corresponding exchange 
rate, the country, and the type of exchange (multiply or divide). 
 
To access the Foreign Exchange Reference, click on the button marked, FX REF, or 
highlight and click on FX Reference in the right-click pop-up menu. 
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Upload Reconciliation 

TIE™ reconciles its output files with the data that trades in the execution system, saving 
traders from having to reconcile the two manually.   
 
An Upload Report appears in a pop-up dialog box when the upload is complete.   
 
Execution system kick outs appear in the first section of the Trade Summary Report, 
and the trading system’s model names are added to the Country folder where orders 
are grouped according to country, side and account. 
 

Upload to the Trade Execution System 

TIE™ allows the user to upload a converted list to any number of Trade Execution 
Systems. The save button will bring up a dialog box asking for the user’s name, the 
strategy and execution type, the identifier the order should be uploaded by, and the 
name of the client.  
 
When a list contains securities that trade both in US and Canada, two radio buttons 
appear in the upper right corner of the dialog box, giving the user the option of 
uploading dually listed securities as Canadian or US. If no selection is made, TIE™ will 
default to the country displayed in the Total folder. 
 
When a list contains Irish securities that trade on the London exchange, two radio 
buttons appear in the upper right corner of the dialog box. If the UKM radio button is 
selected, orders will be uploaded with UKM as the country.  If the IRE radio button is 
selected, orders will be uploaded with IRE as the country.  If neither button is selected, 
TIE™ will default to the country displayed in the Total folder. 
 
A check box gives the user the option of aggregating allocations in the upload, or 
uploading them individually. TIE™’s default mode is to aggregate allocations in the 
upload. 
 
A second check box gives the user the option of uploading test files to Trade Execution 
System without having them added to the Daily Summary Report.  The check box has a 
default check to add the upload to the Daily Summary Report. 
 
As soon as the Save button in the dialog box is clicked, the order is uploaded to the 
trading system and the order information is automatically logged in the Daily Summary 
Report. 
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International Toolbar 

 

 
 
The International toolbar contains five buttons used for setting international security 
identifiers: 
 

1.   The Set ISIN button allows the user to designate an ISIN cell, range or column, 
differentiating it from other similar data and giving the ISIN(s) precedence over 
identifiers that have not been set. 

 

2.   The Set Kassenverein button allows the user to designate a kassenverein cell, 
range or column, differentiating it from other similar data and giving the 
kassenverein(s) precedence over identifiers that have not been set. 

 

3.   The Set Sicovam button allows the user to designate a sicovam cell, range or 
column, differentiating it from other similar data and giving the sicovam(s) 
precedence over identifiers that have not been set. 

 

4.  The Set Valoren button allows the user to designate a valoren cell, range or 
column, differentiating it from other similar data and giving the valoren(s) 
precedence over identifiers that have not been set. 

 

Mismatch Reporting 

TIE™ flags securities whenever the company description the client sent does not match 
the company description in the securities database. 
 

• Description Mismatch error messages appear in the Status column and the Status 
Bar of the Tabular folder.   

• Description Mismatches are flagged with the word “Mismatch” in the Comments 
field of the Total folder and all corresponding side folders. 

• The Mismatch Report folder contains a complete list of Mismatches found in a trade 
list.   

The list of Mismatches is recorded in the Trade Summary Report. 
 

New 

The New button allows the user to create a new grid without clearing what is currently 
on the screen.  
 
TIE™ is a multiple-document interface (MDI) application, allowing multiple documents 
to exist simultaneously.  Normally a user may drag in or open a file over a file that has 
already been converted, automatically clearing the previous list. New allows the user to 
bring up a fresh TIE™ grid so that they can have more than one trade list open on the 
screen at a time. 
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Odd Lot Reporting 

Trade Import Expert™ detects and reports odd lot share quantities.  TIE™ warns the 
trader of Odd Lots rather than preventing an order with an error message.   
 
1. Highlighting a security row in the Tabular folder, displays the trade information for 

the order in the Status Bar at the bottom of the screen.  The words “Odd Lot” will 
begin the string of order data reported in the Status Bar when the share quantity is 
not equivalent to the designated lot size.   

2. Odd Lots are reported in the Comments field of the Total and side output folders.   
3. Complete lists of odd lots, are found in the Trade Summary Report, and Odd Lot 

report folders.   
 
Note: Only Odd Lots for Japanese securities will be displayed in the Status column of 
the Tabular folder. 

Open File 

The Open File button brings up the File Open dialog box.  This allows a user to select a 
file from the directory and open it directly into TIE™. 

Order Status 

 
A status column is provided in the Tabular and Unknown folders.  This column lists the 
status for each security in a trade list.   
 
If the security has been converted, it will display the word “Order” for that row. 
If the security row contains errors or discrepancies, these will be noted by error 
messages. 
 
A detailed display of the order summary or error message can be seen in the Status 
Bar at the bottom of the screen when the particular row is highlighted. 

Paste 

The Paste feature allows the user to paste data from the clipboard into the TIE™ grid.  
This enables the user to paste data from almost any kind of document into Trade Import 
Expert™ for conversion.  Data can be copied from one of the reference dialog boxes 
and pasted into a cell or row in the TIE™ grid. The reverse can also be done, for 
example, the user can copy a sedol from the grid and paste it into the sedol edit control 
in the Security Reference dialog box, to search for that security.  This saves time and 
prevents potential typos that can occur manually. It also enables quick editing of sedols, 
tickers, account names, etc. 

Price out of Range 

When client prices are provided, Trade Import Expert™ compares those prices with the 
prior night’s closing prices.  If there is a discrepancy in a price of plus or minus 5% or 
greater, TIE™ alerts the trader with a red Price Alert Light and calculates the 
percentage of discrepancy between the prices. 
 
The Price Off by… % message is displayed in the Status Bar at the bottom of the 
Tabular grid when a security row is highlighted.  It is also noted in the Comments field 
of the Total folder and side output folders.  The Report includes a Price Off by…% 
section when applicable.  All securities having a price discrepancy may also be viewed 
in the Price report folder. 
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Range Edit Control and Highlighted Ranges 

 

 

Range Edit Control 

Ranges may be specified by using the Range edit controls located in the Control Panel 
to the right of the grid. The range is specified by typing the row numbers of the first and 
last rows of the range into the “Start” and “Stop” Range edit controls. Only those 
securities within a specified range will be converted into orders.  This allows a trader to 
convert a list in sections, or to convert only a partial list. 

Highlighted Ranges 

A range may also be designated by highlighting a group of rows. To create a selection 
range, hold down the left mouse button and drag the mouse to highlight the range area. 
When a range is selected it will be highlighted in reverse video.  Once a range is 
highlighted the user may click on the Convert button to generate orders. Only those 
securities within a specified range will be converted into orders.  This allows a trader to 
convert a list in sections, or to convert only a partial list. 

Report Folder 

The Report folder contains the Trade Summary Report: a comprehensive summary of a 
trade list.   It summarizes countries, counts, shares, sides, local and USD reference 
principals, and USD closing principal.  The Report can include the following sections 
when relevant: TIE™ kick outs, sub-accounts, description mismatches, prices that are 
zero, prices that are out of range, errors, conflicts, unknown lines, securities matched 
by synonyms, odd lots, and, securities on the restricted list, dually listed securities, 
duplicate securities per account, and dummy accounts in use. 
 
The Account, Errors, Mismatch, Odd Lot, Price and Restricted sections of the Report 
are displayed in six individual report folders. 

Resize Window 

All Trade Import Expert™ windows can be resized.  To resize a window, click on the 
perimeter of the window until the cursor arrow becomes a double arrow, and then drag 
the perimeter to expand or condense the window.  Another way to resize the window is 
by using the maximize/minimize button in the upper right hand corner of the window. 

Restricted Reporting 

Restricted securities are listed in the Restricted Report, and Restricted section of the 
Trade Summary Report.  The Total folder, side output folders, and Liquidity Reports 
have a restricted column marked “Rst”.   Securities on the restricted list display a “Y” in 
the restricted column.   

Right Click Menu 

Clicking on the right mouse button displays a selection menu that includes the set 
features, convert command, reference tools, and several editing functions found on 
TIE™’s toolbar. 
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Save 

The upload button(s) send orders to the trade execution system(s) and automatically 
save copies of the output file, the Trade Summary Report, Bid, and Daily reports to the 
user’s directory.  Files are saved as:  filename.username.yymmddhhmmss.report. 

Search Edit Control 

 

 
 
The Search Edit Control allows the user to locate data in a list, such as a sedol or a 
company name by typing it into the edit control.  TIE™ will highlight the first row it finds 
containing matching data.  The Search Edit Control is case sensitive. 

Searching 

Trade Import Expert™ provides a variety of searching capabilities.  Traders have easy 
access to security data and client information directly through TIE™, in addition to being 
able to search for data in a trade list. 

Searching for Information 

• Client names and IDs – use the Client Reference 
 

• Client names, IDs, and a listing of accounts– use the Set Client dialog box 
 

• Client accounts, account mnemonics, internal account numbers – use the Account 
Reference 

• Country abbreviations and descriptions – use the Country Reference 

• Foreign currency exchange rates, currency codes, and countries – use the FX 
Reference 

• Side abbreviations which are automatically recognized – use the Side Reference 

• Security data including: Ticker, RIC, Cusip, Sedol, Quick Code, Company name 
and related security information – use the Security Reference 

FastFind 

TIE™ will instantly search for data a user has highlighted and open the appropriate 
reference dialog box to display the search findings when the user employs FastFind.   
 
To search for information using FastFind, select a cell by clicking on it, hold down the 
Shift key and right click the mouse. 

Searching for data in a List  

 

 
 
The Search Edit Control, located on TIE™'s Control Panel, allows the user to locate 
data in a list, such as a sedol or a company name by typing it into the edit control. 
 
TIE™ will highlight the first row it finds containing matching data. The Search Edit 
Control is case sensitive. 
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Security ID 

The Security ID button allows the user to manually over-ride any “kick-outs.”  By setting 
an identifier cell or column as a Security ID cell or column the order(s) will be uploaded 
to the trading system, including those where the identifier is unknown.  This button acts 
as a failsafe, when there are data errors or problems that might otherwise prevent a 
specific security from being traded.  The upload results for the securities will display the 
selected identifier, as it appears in the list, and for those that were “unknown”, “ZZZ” will 
appear instead of corresponding security data.  The “unknown” securities will be 
represented by the country classification of “ZZZ” in the output folders and reports. 

Security Reference 

The Security Reference dialog box allows the user to search for, add, delete, and 
update security information.   
 
The Security Reference displays the following information, based on the data available 
in the database: Ticker/Quick Code, Cusip, RIC, Sedol, A client’s internal security 
symbol, Canadian Ric, Canadian Sedol, Country, Issuer, Currency, Exchange, 
Restricted, Security comments, ISIN, Kassenverein, Valoren, Sicovam, Closing Price, 
Lot Size, OTC, and 21 day average volume.  Only the edit control marked with an 
asterisk may be used for searching, but all fields may be updated). 
 
To access the Security Reference, click on the button marked, SEC REF or click on 
Security Reference in the right-click pop-up menu.  The Security Reference may also 
be accessed by FastFind (hold down the shift key and right click on the mouse over 
selected data in a list.) 
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Set Client 

The Set Client button brings up a dialog box that allows the user to set or add clients 
and accounts, and to set a default account when required.  Once the user sets a client, 
the client name will appear along with the file name in TIE™’s header bar.  The client 
name will also be pre-selected in the upload dialog box when uploading the order into 
the trading system. 
 

 

Set Refresh Timer 

 

 
 
Trade Import Expert™ has an automated refresh timer that refreshes reference data 
daily at 7am local time. Lists open in TIE™ at 7am are closed automatically, and the 
data TIE™ is drawing from is updated.  
 
This gives the user access to the most up to date reference data, including changes in 
tickers, prices, restricteds, foreign exchange rates, etc. 
 
TIE™'s Refresh feature pre-enabled. If the user decides not to have the reference data 
updated automatically at the pre-set hour, it can be disabled by selecting Clear Refresh 
Timer from the Tools menu at the top of the screen.  Once it has been disabled, it will 
no longer refresh every morning until it is set again. 
 
To set the Refresh Timer, click on Set Refresh Timer in the Tools menu. 
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Set Finance Date Calendar 

TIE™ calculates the number of days to finance an order and includes finance charges 
included in the Bid Report.   
 
To open the Finance Calendar select Tools > Set Finance Date. 
The settlement date is selected by clicking appropriate day on the calendar. The month 
can be changed by paging up and paging down. 
 
If the user opts not to include finance charges in the Bid Report, a check box in the Set 
Finance Date Calendar dialog box temporarily omits the Finance Charge calculation. 
 

 
 
 
Note: The user may enable or disable this feature by checking or un-checking the “Include 
Finance Charges” check box found under Tools > Advanced Features. 
 

Side Radio Buttons 

 
 
The side for an entire order can be changed by clicking on one of the side radio 
buttons, and then clicking the Convert button on the toolbar.  Side changes are instantly 
updated in the Summary Grid located on the Control Panel and in all related output 
folders and reports. 
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Side Reference 

The Side Reference dialog box allows the user to find, insert, and delete side 
abbreviations. 
 
The Side Reference provides a drop-down list box control of the fundamental sides, and 
a Synonym drop-down list box displaying side synonyms in the database. The synonym 
edit control is used for adding additional synonyms.  A list of the seven primary side 
abbreviations is displayed on the dialog box.  
 
To access the Side Reference, click on the button marked SIDE REF, or click on Side 
Reference in the right-click pop-up menu. 
 

 

Side Selection 

Using Side Radio Buttons 

Sides may be designated or changed manually by editing the side abbreviation in a list, 
or automatically through selecting one of the Side radio buttons on the Control Panel 
and clicking on the Convert button.  Selecting a side using the radio buttons will change 
the side for the entire order.  Selecting a range and a side via the side radio buttons will 
convert only the selection range of orders and will apply the side to that range. 
 

Adding side abbreviations for TIE™ to recognize 

Side abbreviations that are not automatically recognized may be temporarily added by 
using the Side Reference dialog box.  See Side Reference under Reference Dialog 
Boxes for information on how add side synonyms in the Side Reference dialog box. 
 

Setting a Side Column 

A side column in a list may be “set” so that the side designations will not conflict with 
accounts or tickers.  This is done by highlighting the side column, clicking on the Set 
Side button on the toolbar, and converting the order. 
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Sorting 

In the Total and side output folders, a list may be sorted by any data category simply by 
double clicking on the column header.   
 
This feature makes locating specific securities fast and easy.  Securities can be 
grouped by side, grouped alphabetically by ticker, RIC, or company name.  They can be 
grouped according to share quantity or even by comments. The sort feature adds 
flexibility to Total and side folders for cross-referencing, editing and proof reading. 
Sorting in the output folders will not affect any output or upload results. 
 
Sorting can also be done in the Tabular folder, but users must be careful when there 
are column headers or account headers in a list, as it may jumble the organization. 

Status Bar 

The Status Bar displays: 1) Order Summaries 2) Error Messages and 3) Reference 
Dialog Box Function Confirmation 

Order Summary and Error Status 

When a row in the Tabular folder is highlighted the Status Bar will display an order 
summary for that row, or, an expanded error message if the row contains an error. 

Reference Dialog Box Function Confirmation 

The Status Bar provides function confirmation for the Reference Dialog Boxes.  (e.g.: if 
the user adds a side abbreviation, it will display either “added side ___…” or “could not 
add side___…” 
 
The Status Bar is located at the bottom of the TIE™ screen. 
This picture illustrates a order summary. 

 
In this illustration, the security has a “Mismatch” error message in the Status column.  
By highlighting that row and checking the company description in the Status Bar, the 
trader can quickly see that the client sent the wrong ticker for the security named in the 
list.  This feature aids the trader in finding errors quickly, and helps prevent trading the 
wrong security. 
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Status Column 

The Tabular folder’s Status Column displays status messages for each row containing 
order information.   
 
When a row is successfully converted, it will read: "Order".   It may also display error 
messages such as “Order – Mismatch” (meaning the company name in the list does not 
match the company name in the database).  It informs the user when a security 
identifier is “undefined” and when there are “conflicts” between security identifiers in a 
given row.  
 

 

Sub-Account Allocation Processing 

Trade Import Expert™ processes sub-account allocations for orders, when sub-
accounts are recognized or "set" during order conversion.  The Total folder and side 
output folders share a feature that displays allocation detail for each order.  To view the 
order/allocation detail, click on the button marked, SUB ACCT on the tool bar. 
Allocation rows are displayed in italic font beneath the order row.  The allocation row 
contains the following attributes: ticker, allocation share quantity, client mnemonic, 
account mnemonic, internal account number, and the allocation’s principal. 
 

 
 
The Country Folder contains a summary of a trade list by country, further summarized 
by side and account.  
 
The Trade Summary Report and the Account report folders contain complete 
summaries for each account, including: total count, shares, and USD and local 
principals, by side. 
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Synonym Matching 

Trade Import Expert™ has the ability to interpret and match securities by synonyms.  If 
a client sends an order with a mixed list of tickers and synonyms, TIE™ will match the 
synonyms with tickers in the database.  A list of securities matched by synonym can be 
found in the Trade Summary Report. Synonym matches are displayed on the Tabular 
folder's Status Bar when individual security rows are highlighted, and in the Total 
folder’s Comments field.  
 
TIE™ recognizes synonyms using a period: VIA.B, no space: VIAB, space: VIA B, 
single quote: VIA'B, and a forward slash: VIA/B. 
 

 

Summary Grid 

The Summary Grid provides the user an instant side, share, and principal reference 
while converting an order.  It is located in the Control Panel on the right side of the 
TIE™ grid. 
 

 
 
The following is a list of the totals included in the Summary Grid: 
T = total count, shares, principal 
B = total buy count, buy shares, buy principal 
S = total sell count, sell shares, sell principal 
C = total cover count, cover shares, cover principal 
S = total short count, short shares, short principal 
-  = total buy minus count, buy minus shares, buy minus principal 
+ = total sell plus count, sell plus shares, sell plus principal 
E = total exempt count, exempt shares, exempt principal 
I = total number of lines in an order 
U = total number of unknown lines/data in an order 
A = total number of alerts 
P = total number of price exceptions 
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Toolbar 

 
 
TIE™'s standard toolbar contains thirty-three separate features.  Feature descriptions 
are arranged alphabetically below. 
 

1. The Account Reference button brings up a dialog box that allows the user search 
for, verify, and update a client’s accounts. 

 

2. The Adjust Font Display Resolution button allows the user to adjust the display 
resolution on systems with a manual font mode.  If Trade Import Expert™  cannot 
display its entire window when it first starts, the Windows™ NT driver is probably 
in large font mode.  When this occurs the grid is visible but the control panel is 
not.  To adjust for screen font problems, click the large/small font button “B/b” on 
the tool bar.  

 

3. The Clear button clears the active data being displayed on the screen.  If the user 
does not wish to clear a file that is open on the screen, but wishes to open another 
file into TIE™ 3.4, then the New button should be used. 

 

4. The Client Reference button brings up a dialog box that allows the user to search 
for, verify, add, and delete client names and IDs. 

 

5. The Convert button is used after setting attributes and making editing changes. 
Clicking the Convert button processes new information and updates the data in 
the output folders. 

 

6. The Copy button allows the user to copy a highlighted selection of data onto the 
clipboard for pasting into TIE™ or other editable document or grid such as 
Microsoft Word or Excel.  The trader can copy data from a reference dialog box 
and insert it into a cell or row in the TIE™ grid.  This enables quick editing of 
sedols, tickers, account names, etc.  The reverse can also be done, for example, 
the user can copy a sedol from the grid and paste it into the sedol edit control in 
the Security Reference dialog box, to search for that security.  This saves time 
and prevents potential typos that can occur manually. 

 

7. The Country Reference button brings up a dialog box that allows the user to 
search for, verify, add, and delete country abbreviations. 

 

8. The Cut button: Clicking on the Cut button will permanently remove the 
highlighted column(s) and/or column(s) containing highlighted data.   

 

9. The Toggle Allocation View button is used while in Total folder or any of the side 
folders.  Click on the button to display the sub-accounts.  Click on the button 
again, to hide the sub-accounts. 

 

10. The Foreign Exchange Reference (FX) button brings up a dialog box that allows 
the user to search for, confirm, or revise exchange rates for foreign currencies.  
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11. The Save To Trade Execution System button brings up a dialog box asking for 
the user’s name, the strategy and execution type, the security identifier the order 
should be uploaded by, and the name of the client. As soon as the Save button in 
the dialog box is clicked, the order is uploaded to the trading system.  

 

12. The New button allows the user to bring up a new TIE™ grid without clearing what 
is currently on the screen. New allows the user to have more than one trade list 
open on the screen at a time.  

 

13. The Open File button brings up a dialog box that allows a user to select a file from 
the directory and open it into TIE™ 3.4.  If a file is currently active on the screen, it 
will be automatically cleared once the directory file is opened.  When a user wants 
to keep a existing data on the screen, and also bring in a new order, then the user 
must click the New button first before opening a new file. 

 

14. The Paste button allows the user to paste data on the clipboard into the TIE™ 
grid.  This enables the user to paste data from most documents into Trade Import 
Expert™ for conversion.  The trader can also paste data copied from a reference 
dialog into a cell or row in the TIE™ grid or from the TIE™ grid into an edit control 
in a dialog box.  This enables quick editing and searching, and prevents potential 
typos that can occur manually. 

 

15. The Print button enables the user to print the contents of a folder that is actively 
displayed on the screen.   

 

16. The Security ID button allows the user to prevent kick-outs. By setting an 
identifier cell, range or column as Security ID, the data set will be uploaded to the 
trading system even when it is not recognized in the database. This button acts as 
a failsafe, when there are data errors or problems that might otherwise prevent a 
specific security from being traded. 

 

17. The Security Reference button brings up a dialog box that allows the user to 
search for, add, delete, and update security information. 

 

18. The Set BBID or Set Bloomberg Code button allows the user to designate a 
column, cell, or range of cells containing Bloomberg codes 

 

19. The Set Client button brings up a dialog box that allows the user to set or add 
clients and accounts, and to set a default account when required.  Once the user 
sets a client, the client name will appear along with the file name in TIE™'s 
header bar.  The client name will also be pre-selected in the upload dialog box 
when uploading the order into the trading system.   

 

20. The Set Country button allows the user the designate a column, cell, or range of 
cells containing country codes, so that they will not conflict with tickers or other 
data. 

 

21. The Set Cusip button allows the user to designate a cusip cell, range or column, 
differentiating it from other similar data and giving the cusip(s) precedence over 
identifiers that have not been set. 
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22. The Set Description button allows the user to designate the company description 
column, differentiating it from other text columns that might be contained in a list. 

 

23. The Set Local Price button allows the user to designate local reference prices to 
be used in the order conversion. The calculated local reference principals will be 
included in the Total and side folders, as well as the Trade Summary Report . 

 

24. The Set Memo button allows the user to include a column of information from an 
input file in the Trade Execution System upload.  The memo data can be viewed 
in Total and side folders. 

 

25. The Set RIC button allows the user to designate a RIC cell, range or column, 
differentiating it from other similar data and giving the RIC(s) precedence over 
identifiers that have not been set. 

 

26. The Set Sedol button allows the user to designate a sedol cell, range, or column, 
differentiating it from other similar data and giving the sedol(s) precedence over 
identifiers that have not been set. 

 

27. The Set Share button allows the user to designate a share cell, range, or column, 
differentiating it from other cells or columns of similar data.  In the case or orders 
with sub-accounts the share column refers to the total shares column, while the 
allocation shares are designated by setting accounts. 

 

28. The Set Side button allows the user to designate a side cell, range, or column, 
differentiating it from other similar data and preventing conflicts that might arise 
with tickers or accounts sharing the same abbreviation. 

 

29. The Set Sub-Accounts button allows the user to designate specific sub-
accounts, by cell, range or column.  

  

30. The Set Ticker button allows the user to designate a ticker cell, range or column, 
differentiating it from similar data and giving the ticker(s) precedence over 
identifiers that have not been set. 

 

31. The Set USD button allows the user to designate USD reference prices to be 
used in the order conversion.  The calculated USD reference principals will be 
included in the Total  and side folders, as well as the Report that is generated for 
the converted order. 

 

32. The Side Reference button brings up a dialog box that allows the user to search 
for, confirm, and temporarily add side abbreviations. 
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Trade List Reconciliation 

Trade Import Expert™ will reconcile results when the input data contains trade 
summary information.  Reconciliation LEDs give immediate visual feedback on the 
results of the conversion. 
 

    
 
If no trade summary information is provided, the LEDs will remain grayed.  If there are 
trade summary records in a list and the numbers correspond to the sum of the buys, 
sells or totals, then TIE™ will set the appropriate LEDs green.  If sum(s) are not 
equivalent, the LEDs will be red. 
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7.  INPUT FOLDERS 

Input Folders 

 
 
TIE™ has three input folders: the Input folder, for viewing raw or unprocessed input 
data, the Excel™ folder for Excel™ worksheets and manual trade entry, and the 
Tabular folder for viewing and editing columnized input. 

Input Folder 

 
 
The Input folder displays a file’s data exactly it is received (raw input). All field delimiters 
including tabs, commas, and spaces are displayed as they are read. The Input folder 
does not process field delimiters. 
 
TIE™’s Input folder provides syntax highlighting of side synonyms, helping the user to 
quickly spot the side(s) that have been designated in a list’s text. 
 
After editing changes have been made in other folders for conversion, the original input 
the client sent can be viewed in the Input folder. 

Excel™ Folder 

 
 
TIE™’s Excel™ folder is for processing Excel™ worksheets and for manual order entry. 
 
When a client’s Excel™ file has multiple sheets, tabs and scroll bars appear at the 
bottom of TIE™’s Excel™ folder so that any worksheet in the group may be selected 
and converted.  Once a worksheet has been selected, the user clicks on the Convert 
button to enter the data into the Tabular folder. TIE™ processes only the worksheet that 
has been selected. 
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The Excel™ folder processes formulas but does not execute Excel™ macros.  Editing 
can be done at the cell, column, row, or range level.  See the section on Editing in the 
Excel™ folder for more detailed information on the editing features provided. 

Tabular Folder 

 
 
The Tabular folder displays input data as an editable grid of rows and columns. TIE™ 
automatically computes the column boundaries from the input file and provides 
“guesses” as to a column’s type. TIE™'s guesses are displayed in the Tabular folder's 
column headers.  These guesses may be manually overridden using the “Set” attribute 
buttons. 
 
The Tabular folder gives a user instant order feedback in its Status Column and on its 
Status Bar.  Errors, Mismatches, Undefined Security IDs, Conflicts, Odd Lots, Dually 
Listed Securities, Unknown Side symbols, Unknown Accounts, and Duplicate Security 
per Account(s) are reported in these status fields. 
 
There are a wide variety of editing features available in the Tabular folder.  The user 
may adjust a column’s width, change data alignment, manually edit data, sort the list, 
automatically search reference data using FastFind, automatically edit data using 
FastFind Paste, automatically transpose characters from upper case ‘A’ to lower case 
‘a’ and the reverse, copy and paste, and bisect and merge columns.   
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8.  OUTPUT FOLDERS 

Output Folders 

 

 
 
TIE™ has ten output folders.  The first folder, the Country folder contains a summary by 
country, further summarized by side and/or accounts when a trade list includes multiple 
sides and/or accounts.  The second folder, the Total folder, contains a mixed list of all 
orders recognized.  The next seven folders contain orders filtered by side.  The last 
folder, the Unknown folder, contains all data that was unrecognized or has errors.  The 
Unknown folder is an input/output folder that is used to display and correct errors.  
Corrections made in the Unknown folder may be applied incrementally to the converted 
list. 

Buy Folder 

 
 
The Buy folder displays the details for each “Buy” order in a list. 
 
From left to right it displays the following information: side, ticker, RIC, exchange, total 
number of shares, local price, USD price, country, cusip, sedol, company name, 
industry, Bloomberg Code, ISIN, kassenverein, valoren, sicovam, local principal, USD 
principal, destination, restriction, memo, and comments including: odd lots, prices out of 
range and description mismatches. 
 
In addition, it provides details for all orders with sub-account allocations.  These may be 

viewed by clicking on the button marked “Sub Acct”.    The button can be toggled 
to display either the order totals or the sub-account details. 
  
All cells in the Buy folder may be edited.  Certain fields have input validation (example: 
the side field will only take valid sides, the ticker field will only take valid tickers, etc… 
otherwise the data reverts back to the original data). 
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Buy- Folder 

 
 
The Buy- folder displays the details for each “Buy-” order in a list. 
 
From left to right it displays the following information: side, ticker, RIC, exchange, total 
number of shares, local price, USD price, country, cusip, sedol, company name, 
industry, Bloomberg Code,  ISIN, kassenverein, valoren, sicovam, local principal, USD 
principal, destination, restriction, memo, and comments including: odd lots, prices out of 
range and description mismatches. 
 
In addition, it provides details for all orders with sub-account allocations.  These may be 

viewed by clicking on the button marked “Sub Acct”.    The button can be toggled 
to display either the order totals or the sub-account details. 
 
 
All cells in the Buy- folder may be edited.  Certain fields have input validation (example: 
the side field will only take valid sides, the ticker field will only take valid tickers, etc… 
otherwise the data reverts back to the original data). 

Buy To Cover Folder 

 
 
The Buy to Cover (Cover) folder displays the details for each “Cover” order in a list. 
 
From left to right it displays the following information: side, ticker, RIC, exchange, total 
number of shares, local price, USD price, country, cusip, sedol, company name, 
industry, Bloomberg Code,  ISIN, kassenverein, valoren, sicovam, local principal, USD 
principal, destination, restriction, memo, and comments including: odd lots, prices out of 
range and description mismatches. 
 
In addition, it provides details for all orders with sub-account allocations.  These may be 

viewed by clicking on the button marked “Sub Acct”.    The button can be toggled 
to display either the order totals or the sub-account details. 
 



Trade Import Expert�   Chapter 8: Output Folders 

Software Intelligence, Inc. © 2001 61

All cells in the Cover folder may be edited.  Certain fields have input validation 
(example: the side field will only take valid sides, the ticker field will only take valid 
tickers, etc… otherwise the data reverts back to the original data). 

Country Folder 

 
 
The Country folder contains a summary of the trade list organized by country, side and 
account.  This includes counts (number of securities traded), total shares, local and 
USD values, further summarized by side and/or accounts, when a trade list includes 
multiple sides and/or accounts. 
 
The Country folder also provides reconciliation confirmation for uploads. TIE™ 
reconciles the upload results with TIE™’s output data and displays the execution 
system model names, or the word “Error” if un-reconciled, in the model field. 
 
Sides in the Country folder are color coded according to Buys and Sells (Green and 
Red).  Note that in the picture above the “BY” as well as the “BC” account summaries 
are in Green, and the “SL” as well as the “SS” account summaries are in Red. 

Sell Folder 

 
 
The Sell folder displays the details for each “Sell” order in a list. 
 
From left to right it displays the following information: side, ticker, RIC, exchange, total 
number of shares, local price, USD price, country, cusip, sedol, company name, 
industry, Bloomberg Code,  ISIN, kassenverein, valoren, sicovam, local principal, USD 
principal, destination, restriction, memo, and comments including: odd lots, prices out of 
range and description mismatches. 
 



Trade Import Expert�   Chapter 8: Output Folders 

Software Intelligence, Inc. © 2001 62

In addition, it provides details for all orders with sub-account allocations.  These may be 

viewed by clicking on the button marked “Sub Acct”.    The button can be toggled 
to display either the order totals or the sub-account details. 
 
All cells in the Sell folder may be edited.  Certain fields have input validation (example: 
the side field will only take valid sides, the ticker field will only take valid tickers, etc… 
otherwise the data reverts back to the original data). 

Sell+ Folder 

 
 
The Sell+ folder displays the details for each “Sell+” order in a list. 
 
From left to right it displays the following information: side, ticker, RIC, exchange, total 
number of shares, local price, USD price, country, cusip, sedol, company name, 
industry, Bloomberg Code, ISIN, kassenverein, valoren, sicovam, local principal, USD 
principal, destination, restriction, memo, and comments including: odd lots, prices out of 
range and description mismatches. 
 
In addition, it provides details for all orders with sub-account allocations.  These may be 

viewed by clicking on the button marked “Sub Acct”.    The button can be toggled 
to display either the order totals or the sub-account details. 
 
All cells in the Sell+ may be edited.  Certain fields have input validation (example: the 
side field will only take valid sides, the ticker field will only take valid tickers, etc… 
otherwise the data reverts back to the original data). 

Sell Short Folder 

 
 
The Sell Short (Short) folder displays the details for each “Short” order in a list. 
 
From left to right it displays the following information: side, ticker, RIC, exchange, total 
number of shares, local price, USD price, country, cusip, sedol, company name, 
industry, Bloomberg Code,  ISIN, kassenverein, valoren, sicovam, local principal, USD 
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principal, destination, restriction, memo, and comments including: odd lots, prices out of 
range and description mismatches. 
 
In addition, it provides details for all orders with sub-account allocations.  These may be 

viewed by clicking on the button marked “Sub Acct”.    The button can be toggled 
to display either the order totals or the sub-account details. 
 
All cells in the Short folder may be edited.  Certain fields have input validation (example: 
the side field will only take valid sides, the ticker field will only take valid tickers, etc… 
otherwise the data reverts back to the original data). 

Short Exempt Folder 

 
 
The Short Exempt (Exempt) folder displays the details for each “Short Exempt” order in 
a list. 
 
From left to right it displays the following information: side, ticker, RIC, exchange, total 
number of shares, local price, USD price, country, cusip, sedol, company name, 
industry, Bloomberg Code, ISIN, kassenverein, valoren, sicovam, local principal, USD 
principal, destination, restriction, memo, and comments including: odd lots, prices out of 
range and description mismatches. 
 
In addition, it provides details for all orders with sub-account allocations.  These may be 

viewed by clicking on the button marked “Sub Acct”.    The button can be toggled 
to display either the order totals or the sub-account details. 
 
All cells in the Exempt folder may be edited.  Certain fields have input validation 
(example: the side field will only take valid sides, the ticker field will only take valid 
tickers, etc… otherwise the data reverts back to the original data). 

Total Folder 

 
 
The Total folder displays the details for each order in a list.   
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Sides are color coded according to the colors displayed in the Summary Grid: 
Buy:Green, Sell:Red, Cover:White, Short:Purple, Buy-:Turquoise, Sell+:Violet, 
Exempt:Pale Green. 
 
From left to right it displays the following information: side, ticker, RIC, exchange, total 
number of shares, local price, USD price, country, cusip, sedol, company name, 
industry, Bloomberg Code, ISIN, kassenverein, valoren, sicovam, local principal, USD 
principal, destination, restriction, memo, and comments including: odd lots, prices out of 
range and description mismatches. 
 
In addition, it provides details for all orders with sub-account allocations.  These may be 

viewed by clicking on the button marked “Sub Acct”.    The button can be toggled 
to display the order totals or the sub-account details. 
 

 
 
All cells in the Total folder may be edited.  Certain fields have input validation (example: 
the side field will only take valid sides, the ticker field will only take valid tickers, etc… 
otherwise the data reverts back to the original data). 

Unknown Folder 

 
 
The Unknown folder contains input data that could not be converted.  It displays the 
unrecognized lines and error messages as seen in the Tabular folder, but with the 
converted orders filtered out.   
 
Editing in the Unknown folder includes the same features as the Tabular folder, allowing 
for: column bisect, merge, cut, and alignment operations, as well as setting attributes. 
 
Editing and converting while in the Unknown folder will produce corrections in the 

output and report folders, but not in the Tabular, Input, or Excel  folders, which are 
input folders and are located “up stream” in the order process.  If the user plans on 
making additional editing changes in the Tabular folder after making corrections, then 
the corrections should be made in the Tabular folder to avoid the loss of those changes 
when the order is reconverted.  Reconverting while in Tabular will convert the data that 
is in the Tabular folder, and changes previously made in the Unknown folder will be lost. 
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For lengthy trade lists the Unknown folder is a very useful tool for spotting errors and 
making rapid changes to convert an order quickly. 
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9.  REPORTS/REPORT FOLDERS 

 

Report Folders 

 

 
 

 
TIE™ has a series of report folders, which vary according to client requirements.  
Standard report tabs are pictured above; additional reports (not pictured) such as 
Liquidity and OTC are described in this User’s Guide.  Custom reports can be created 
and new report tabs added to the interface. 
 
The folder tab marked “Report” contains the Trade Summary Report for the converted 
list. It summarizes countries, accounts, security counts, shares, sides, local and USD 
reference principals, and USD closing principal.  The Report can include the following 
sections when relevant: Sub-Accounts, Kick Outs, Description Mismatches, Prices that 
are Zero, Prices that are Out of Range, Errors, Conflicts, Unknown Lines, securities 
Matched by Synonym, Odd Lots, and, securities that are on the Restricted list. 
 
The next six report folder tabs to the right of the Report folder tab {Errors, Account, Odd 
Lot, Mismatch, Price, and Restrict} show the individual sections of the Report. This 
allows the trader to view trade specifics, without having to scroll through a larger report. 
 
The Daily folder tab indicates the Daily Summary Report.  The Daily folder contains a 
daily summary report of all trade lists uploaded into the trading system(s). 
 
The Bid folder tab marks the Bid Report.  The Bid folder displays bid information for the 
converted trade list. TIE™ calculates the commission, tax, and clearing cost, and 
finance cost (optional), for the order by country and side, and displays the results in 
dollars and basis points.  Bid reports are automatically saved to the user’s archive 
directory when an order is uploaded. 
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Account Report 

 

 
 

The Account Report 

The Account Report provides a summary of each sub-account represented in a trade 
list. To view the Account Report, click on the Account folder tab. 

 
Each account’s summary includes security counts and share quantities by country and 
by side, as well as, Local and USD client principals and the USD closing principal. 

 
When a list has been successfully uploaded into Trade Execution System, the Model 
created for each account will appear in the first column of the report.  The model names 
indicate that the accounts have been reconciled.  If an account did not reconcile the first 
column will read “Error.” 

 
Note: The Account Report shows Trade Execution System account abbreviations when there is 
no internal account number and the client’s external account name is greater than seven 
characters. 
 
 

Bid Report 

 

 
 

The Bid Report 

The Bid Report is a transaction cost report for the converted trade list.  To view the Bid 
Report, click on the folder tab marked Bid. 
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Bid Report Calculations 

TIE™ calculates the commission, buy and sell taxes, clearing costs, finance cost 
(optional), and summarizes these by country and side. The total costs are displayed in 
USD and in basis points. 
 

 

 

Printing the Bid Report 

The Bid Report, which requires scrolling in order to view all the contents, prints in 
landscape mode and is automatically resized to print on one page width, using standard 
8.5” x 11” paper. 
Click the Print button on TIE™’s toolbar to print a hard copy report. 
 

Saving the Bid Report 

Clicking on the Bid Report tab activates a save command that automatically saves a 
copy of the Bid Report to the user’s Report directory. The bid file is saved as an Excel™ 
worksheet whose name is the file name plus the suffix “.user.date/time.bid.xls”. 
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Daily Summary Report 

 
 

The Daily Summary Report 

The Daily Summary Report logs and summarizes trade lists uploaded into the trading 
system for a specific day.  To view the Daily Summary Report click on the report folder 
tab marked Daily. 

 
The Daily Summary Report includes: the time a list was uploaded, the client name, the 
type and strategy of the trade, the region (domestic or international), the number of buy 
shares, sell shares, and total shares, the buy principal, sell principal, net principal, and 
total principal both for the individual uploads and cumulatively for the day.  Grand totals 
are given at the bottom of the summary and updated each time a new order is 
uploaded. 
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Errors Report 

The Errors Report 

The Errors Report provides a summary of security errors and conflicts found in a trade 
list.  It can be viewed by clicking on the Errors report folder tab. 

 
The Errors Report shows the user the location of an error in a list by providing the row 
number and a ruler showing the line positions of the data. 
 

 
 

Liquidity Reports (International and US) 

  US Liquidity Report 

The US Liquidity Report is multi-tabbed with a Summary page and a breakdown 
according to side. TIE™ displays each security's ticker, exchange, number of shares 
trading, 21-day Liquidity, 21-day Average Volume, Closing Price, and a Restricted "Y" 
mark if a security is on the Restricted list. The Liquidity Report summary tables show 
both the number of shares and the number of securities that are trading as NYSE, 
AMEX, OTC market makers, and OTC non-market makers, and each category's 
percent of the list's total principal. 

  International Liquidity Report 

The International Liquidity Report is multi-tabbed with a Summary page and a 
breakdown according to side. TIE™ displays each security's symbol, number of shares 
trading, 21-day Liquidity, 21-day Average Volume, Closing Price, and a Restricted "Y" 
mark if a security is on the Restricted list. The International Liquidity Report summary 
tables show the number of securities and shares that fall within designated liquidity 
ranges. The aggregate portfolio value and weight of the securities is given for each 
range. 
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Mismatch Report 

The Mismatch Report 

The Mismatch Report provides a summary of all orders where the company description 
in a list does not exactly match the company name found in the security database. 

 
The Mismatch Report includes the row number, the first 80 characters of the client’s 
input line followed by a slash (/) and then the company name from the security 
database.  This organization facilitates quick comparisons. 
 

 
 

Description Mismatch error messages appear in the Status Column of the 
Tabular folder when an order is converted.  The user can click on a row to read 
the summary for that order on the Status Bar at the bottom of the screen.  The 
Status Bar will display the company name from the database.  The Mismatch 
Report gives a trader the additional flexibility of being able to view all the 
mismatches in a list at once.  This allows the user to quickly determine which 
securities (if any) need to be corrected. 
 

Odd Lot Report 

The Odd Lot Report 

The Odd Lot Report provides a summary of orders whose number of shares is 
inconsistent with the security’s lot size. 

 
This report displays the Ticker, RIC, Cusip or Sedol, Shares, Side, Country, Price, 
Principal, Company Name, and Lot Size. 
 
NOTE:   Japanese Odd Lots: 
Odd lots for Japanese orders are also displayed in the Status Column of the Tabular folder.   

 
NOTE:  Other places Odd Lots are noted: 
Odd lots for all other countries (including Japan) are noted in the Tabular folder’s Status Bar 
when an individual order row is clicked on.  
Odd Lot messages also appear in the Comments field of the Total folder and the “side” folders. 
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OTC Market Maker Report 

The OTC Report 

The OTC Market Maker Report shows all OTC securities in a list and breaks them into 
two categories:  

• Market Makers: the OTC securities for which the firm makes a market. 

• Non-Market Makers: the OTC securities for which the firm does not make a market.  

Price Report 

The Price Report 

The Price Report is a two-sectioned report that summarizes price errors in a converted 
trade list. 

Reporting Zero Prices 

The first section, Price is Zero, displays all the securities in a trade list that have a 
closing price of zero in the database. 

 
TIE™ recognizes that information in a database can be incomplete; therefore, TIE™ 
automatically searches for the converted orders that have zero as their closing price 
and displays them in the Price Report. This feature enables traders to easily locate and 
correct the data errors. 

Reporting Client Prices that are Out of Range 

The second section, Price is off by +/- 5%, shows the securities in a trade list whose 
client reference price is out of range when compared to the closing price by an amount 
greater than or equal to plus or minus 5%. 

 
The Price Out of Range section displays a percentage value for the discrepancy 
between the client reference price and the closing price. 
 
 

 
 
The Price Report displays the Ticker, RIC, Cusip or Sedol, Shares, Side, Country, Price, Principal, and 
Company Name, for each security with a price error. 
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Report Folder – see Trade Summary Report 

Restricted Report 

The Restricted Report 

The Restricted Report provides a summary of the securities in a trade list that are 
restricted. To view the Restricted Report, click on the report folder tab marked Restrict. 
 
NOTE:  Other places Restricteds are noted: 

• A Restricted column is found in the Total and “side” folders.  The column marked “Rst” will 
contain a “Y” if the security is Restricted.  

• The US and International Liquidity Reports include a column marked “Rst” where the 
individual securities are itemized.  This column will contain a “Y” when the security is 
Restricted. 

Trade Summary Report 

The Trade Summary Report 

The Trade Summary Report provides a comprehensive summary of a trade list. It can 
be viewed by clicking on the folder tab marked Report. 

 
The securities in the trade list are summarized by country, count, shares, and side.  The 
local and USD reference principals, and the USD closing principal are calculated and 
displayed for each of the summary criteria. 
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Trade Summary Report Sections 

The Trade Summary Report can include the following sections when relevant: kick outs, 
sub-accounts, duplicate securities, dummy accounts in use, dually listed securities, 
description mismatches, prices that are zero, prices that are out of range, errors, 
conflicts, unknown lines, securities matched by synonyms, odd lots, and securities that 
are on the restricted list. 
 

 
 
Specific sections of the Report are displayed in the six folders to the right of the Report 
Folder. For more detailed information on these sections of the Trade Summary Report, 
please refer to the information provided for each of the individual reports. 

Upload Reports 

The Upload Reports give the user confirmation of upload results. 
 
Upload Reports will vary according to client specifications and system requirements. 
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10.  ERROR DETECTION 

Alert Lights 

Trade Import Expert™ warns the trader, through a series of Alert lights, if there are 
problems with security data in a trade list. 
 

TIE™ generates alerts for four different situations: 

• Unknown security identifiers 

• Conflicts between security identifiers 

• Prices out of range   

• Allocation imbalances 
    

A green LED indicates no conflict.  A gray LED means that the alert is not applicable.  A 
red LED indicates a conflict.   
 

 
 
The Security Alert lets the user know if there are any unknown security identifiers in a 
list.   
 
The Conflict Alert lets the user know if there are securities in a list that have not been 
converted into orders due to data conflicts.   
 
The Price Alert indicates whether the prices given in a list are +/- 5% over or under the 
prior night’s closing price.   
 
The Allocation Alert indicates sub-account allocation imbalances, and will only be lit 
when sub-accounts are present in a list. 

Dually Listed Warning 

Trade Import Expert™ warns the trader when there are dually listed securities in a list.   

Default Security Selection 

When a dually listed security identifier has been sent by the client TIE™ will select the 
default security. {US/Canadian dually listed securities, TIE™ defaults to the US 
security.  UKM/IRE dually listed securities, TIE™ defaults to the Irish security.} 

Dually Listed Warnings appear in: 

1. Tabular folder Status Bar when an individual order row is highlighted 
2. Total folder Comments Field  
3. Report folder (Trade Summary Report) Dually Listed Securities section 

Duplicate Internal Accounts Warning 

TIE™ warns the user when different account names used in the list share the same 
internal account number.  These accounts will be listed in the Account Report and in the 
Duplicate Internal Accounts section of the Trade Summary Report. 
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Duplicate Security per Account Warning 

Securities that are listed more than once under the same account are noted with a 
"Duplicate Account” warning in the Tabular folder Status Column, the Total folder 
Comments field, and in the Trade Summary and Account Reports. 

Errors Report 

The Errors Report folder provides a two-sectioned summary of the security errors and 
conflicts found in a trade list. 

Mismatch Reporting 

TIE™ will warn users of securities in a list whose company description does not match 
the company description in the securities database. 

Mismatch Report Folder 

 

 
 
The Mismatch Report folder provides a summary of the company description 
mismatches in a trade list.  Description mismatches refer to orders where the company 
description provided in the trade list does not match the company name found in the 
security database. 
 
The Mismatch Report includes: the line number, the first 80 characters of the client’s 
input line, followed by a slash (/) and the company name from the security database.  
This organization facilitates quick comparisons. 

Mismatch Warnings appear in: 

1. Tabular folder Status Column  
2. Total folder Comments Field  
3. Report folder (Trade Summary Report) Company Description Does Not Match 

section 
4. Mismatch Report 
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Odd Lot Reporting 

Trade Import Expert™ detects and reports odd lot share quantities.  TIE™ warns the 
trader of Odd Lots rather than preventing an order with an error message. 

Odd Lot Report 

Trade Import Expert™'s Odd Lot Report provides a summary of all orders where the 
number of shares being traded is inconsistent with the security’s lot size. 

Odd Warnings appear in: 

1. Tabular folder Status Bar when an individual order row is highlighted; warnings 
display the security’s lot size 

2. Total and side output folders Comments field  
3. Trade Summary Report, Odd Lot section 
4. Odd Lot Report   
5. Odd Lot warnings for Japanese securities appear the Tabular folder Status Column  

Order Status 

A Status Column is provided in the Tabular and Unknown folders.  This column lists the 
status of each security in a trade list.   
 
Securities that have been converted, will display the word “Order” in the Status 
Column.. 
If a security row contains errors or discrepancies, these will be noted by error 
messages. 
 
A detailed display of the order or error message can be seen in the Status Bar at the 
bottom of the screen when the individual row is highlighted. 

Price Error Reporting 

Price Out of Range 

When a client provides reference prices in a trade list, Trade Import Expert™ compares 
those prices with the prior night’s closing prices.  If there is a discrepancy in a price of 
plus or minus 5% or greater, TIE™ alerts the trader and calculates the percentage of 
discrepancy in prices. 

• A red Price Alert light indicates that one or more of the prices in a list is off. 

Price Out of Range Warnings appear in: 

1. Tabular folder Status Bar when an individual order row is highlighted; the warning will 
read: Price Off by… %  

2. Price Off by… % messages are noted in the Comments field of the Total and side 
folders. 

3. The Trade Summary Report includes a Price Off by…% section, when applicable.  
4. The Price report folder displays securities with a price discrepancy. 

Price Report Folder 

The Price Report is a two-sectioned report which summarizes the securities in a trade 
list that have a zero price in the database, and the securities in a trade list whose 
reference prices are out of range from the prior night's closing prices by greater than or 
equal to plus or minus 5%. 
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Reconciliation 

Trade List Reconciliation 

Trade Import Expert™ will reconcile results when the input data contains trade 
summary information.  Reconciliation LEDs give immediate visual feedback on the 
results of the conversion. 
 

    
 
If no trade summary information is provided, the LEDs will remain grayed.  If there are 
trade summary records and the numbers correspond to the sum of the buys, sells or 
totals, then TIE™ will set the appropriate LEDs green.  If there are discrepancies 
between the trade summary records and the sum of the buys, sells or totals, then the 
appropriate LEDs will be red.  

Upload Reconciliation 

TIE™ reconciles its results with the Trade Execution System upload results, saving the 
traders from having to manually reconcile the two.  Trade Execution System model 
names created during the upload are displayed in the TIE’s Country folder.  When the 
results of the conversion do not match the results of the upload, the word "error” will be 
displayed in the Model column of the Country folder. 

Restricted Reporting 

Restricted Report 

The Restricted Report provides a summary of all the securities in a trade list that are 
restricted. 

Restricted Warnings appear in: 

1. the Trade Summary Report’s Restricted section, when applicable.  
2. the Restricted Report folder  
3. the Total and side folders include a restricted column marked “Rst”; when a “Y” 

appears in the column the security is restricted 
4. the Liquidity Reports detail pages include a restricted column marked “Rst”; when a 

“Y” appears in the column the security is restricted 

Security Comments Warning 

The Security comments warning is used to help notify traders of any product with 
special circumstances (i.e. - one that is illiquid - or, perhaps it's local ownership of 
shares for 'foreigners' is full. etc.. ).  It does not cause a kickout, but is printed on the 
upload reports for review. 

Security Comment Warnings appear in: 

1. the Status Column and Status Bar of the Tabular folder. 
2. the Comments field of the Total and side folders.  
3. a Security comments section is included in the Trade Summary Report. 



Trade Import Expert�   Chapter 10: Error Detection 

Software Intelligence, Inc. © 2001 79

Status Bar 

The Status Bar, located at the bottom of the TIE™ screen, serves several purposes: 

• Security Summary 

• Error Status 

• Reference Dialog Box Function Confirmation 

Security Summary 

While in the Tabular folder, a user can highlight a row with an “Order” status to view a 
summary of the security in the Status Bar. 
 
The summary includes: Side, Total Aggregate Shares, the A client’s internal security 
symbol, RIC, Cusip, Country, Price (client/reference price when included in the list; the 
closing price if no client price is given) the Company Name, and odd lot, mismatch, or 
synonym notations when applicable. 

Error Status 

While in the Tabular and Unknown folders, a user can highlight a row containing an 
error message in the Status Column to view the extended error message in the Status 
Bar. 

Reference Dialog Box Function Confirmation 

When using a reference dialog box, the Status Bar gives the user feedback on the 
functions performed.  It confirms search findings, updates, deletions and additions, and 
will let the user know when no match was found for a search, or if data could not be 
updated. 
 
This picture illustrates a security summary in the Status Bar. 

 
 
In this illustration, the security has a “Mismatch” error message in the Status column.  By clicking 
on the row and checking the company description in the Status Bar, the trader can quickly see 
that the client sent the wrong ticker for the security named in the list.  This feature aids the trader 
in finding errors, making corrections quickly, and helps prevent trading the wrong security. 

Status Column 

The Tabular folder’s Status Column displays status messages for each row containing 
order information. Clicking on a cell in the Status Column displays order and/or error 
detail on the Status Bar. 
 
When a row is successfully converted, it will read: "Order".   It may also display error 
messages such as “Order – Mismatch” (see the previous illustration).  It informs the 
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user when a security identifier is undefined or when there are conflicts between more 
than one security identifier in a given row.   
 
Users may sort by the Status Column, bringing all the rows with errors to the top. 
The Status Column is also present in the Unknown folder. 
 

 

Summary Grid 

The Summary Grid provides the user an instant side, share, and principal reference 
while converting an order.  It is located in the Control Panel to the right side of the TIE™ 
screen. 
 

 
 
The following is a list of the totals included in the Summary Grid: 
T = total count, shares, principal 
B = total buy count, buy shares, buy principal 
S = total sell count, sell shares, sell principal 
C = total cover count, cover shares, cover principal 
S = total short count, short shares, short principal 
-  = total buy minus count, buy minus shares, buy minus principal 
+ = total sell plus count, sell plus shares, sell plus principal 
E = total exempt count, exempt shares, exempt principal 
I = total number of lines in an order 
U = total number of unknown lines/data in an order 
A = total number of alerts 
P = total number of price exceptions 
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Trade Summary Report 

The Trade Summary Report can include the following sections when they apply to a list:  

• Trade Execution System kick outs 

• TIE kick outs 

• unknown sub-accounts 

• duplicate accounts 

• company description mismatches 

• prices that are zero 

• prices that are out of range 

• errors 

• conflicts 

• unknown lines 

• odd lots 

• restricted securities 

• dually listed securities 

• securities matched by synonyms 

• security comments warnings. 
 

Note:  Not all of these are errors, but they are noted so that the trader is aware the information 
may need to be confirmed before trading. 

Unknown Account Warning 

TIE™ recognizes client names and their accounts.  When TIE™ detects accounts in the 
trade list it automatically generates the allocations.  If information within a range of 
account names is not recognized as an existing client account, TIE™ will display a “cut 
or set column” request or post an “Unknown Account” message in the Tabular folder’s 
Status Column. 

Unknown Side Warning 

TIE™ recognizes over 62 different side synonyms in a variety of languages, as well as 
the symbols that indicate buy or sell shares.  If information within a range of recognized 
side synonyms is not recognized as an existing synonym, TIE™ will display an 
“Unknown Side” message in the Tabular folder’s Status Column. 
If no indication of the side is given in the list, a pop-up warning request the user  

Upload Reconciliation 

TIE™ reconciles each row in the Country folder with models created by the execution 
system.  The trades are grouped by side and country. If the count of securities and total 
shares for each country and side are an exact match with those in the model, TIE™ will 
insert the execution system’s model name into the Country folder.  If they do not match, 
TIE™ will insert the word “Error” in place of a model name. 
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11.  ERROR MESSAGES: CAUSES & RESOLUTIONS 

Click on Shares 

Problem: 

• TIE cannot determine the share quantity 

Causes: 

• More than one column contains numerical data 

• Share quantities are listed across multiple accounts  

Solution: 

1. Set all accounts when applicable.  
2. Set the share column when applicable. 
3. Convert the order. 

Option: 

1. Cut or set other columns containing numerical data. 
2. Convert the order. 

Conflict Messages 

TIE™ reports conflicts in security identifiers.  When the client sends more than one 
security ID, but the ID’s point to two different securities, TIE™ catches the error and 
prevents an order.  To resolve the issue, the user should set the correct identifier or edit 
the information to correct the problem and reconvert the order. 
Other data that matches security attributes can also create conflicts. 
 

Examples of Conflicts and Resolutions 

Conflict: Account/Side 

Problem: 

• TIE cannot determine if the data is an account or a side. 

Cause: 

• A string of characters matches a client’s account name as well as a side synonym.  

Solution: 

1. Cut or set the column containing the symbol with the conflict. 
2. If the symbol is an account, set the column or cell as account. 
3. If the symbol is a side, set the side column or cell as side 
4. Convert the order. 

Conflict: Account/Ticker 

Problem: 

• TIE cannot determine if the data is an account or a ticker. 



Trade Import Expert�   Chapter 11: Error Messages 

Software Intelligence, Inc. © 2001 83

Cause: 

• A string of characters matches a ticker as well as a client account name.  

Solution: 

1. Cut or set the column or cell containing the symbol with the conflict. 
2. Convert the order. 

Conflict: Country/Account 

Problem: 

• TIE cannot determine if data refers to a country or to an account. 

Cause: 

• A string of characters matches a country code and a client account.  

Solution: 

1. Cut or set the column containing the symbol with the conflict. 
2. If the symbol is an account, set the account column, range, or cell  
3. Convert the order. 

Conflict: Country/Ticker 

Problem: 

• TIE cannot determine if the data refers to a country or a ticker. 

Cause: 

• A string of characters matches a country code and a ticker.  

Solution: 

1. Set or Cut the column containing the symbol with the conflict 
2. Convert the order. 

Conflict: Cusip/Valoren 

Problem: 

• TIE cannot determine which security is to be traded. 

Cause: 

• Two nine-digit numbers match the cusip and valoren of two different securities. 

Solution: 

1. Set the column containing the correct security identifier. 
2. Set the share column (to circumvent nine-digit shares that may resemble security 

identifiers). 
3. Convert the order. 

Option: 

1. Edit or replace the incorrect identifier. 
2. Convert the order. 
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Conflict: Exchange/Ticker 

Problem: 

• TIE cannot determine if data refers to an exchange or a ticker 

Cause: 

• A string of characters matches both an exchange and a ticker 

Solution: 

1. Set or cut the column containing the symbol with the conflict 
2. Convert the order. 

Conflict: Kassenverein/Sicovam 

Problem: 

• TIE cannot determine which security is to be traded. 

Cause: 

• Two six-digit numbers match the kassenverein and sicovam of different securities. 

Solution: 

1. Set the column containing the correct security identifier. 
2. Set the share column (six-digit shares may resemble security identifiers). 
3. Convert the order. 

Option: 

Edit or replace the incorrect identifier and re-convert the order. 

Conflict: Kassenverein/Sedol 

Problem: 

• TIE cannot determine which security is to be traded. 

Cause: 

• Two six-digit numbers match the kassenverein and sedol of two different securities. 

Solution: 

1. Set the column containing the correct security identifier. 
2. Set the share column (six-digit shares may resemble security identifiers). 
3. Convert the order. 

Option: 

• Edit or replace the incorrect identifier and re-convert the order. 
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Conflict: Sedol/Cusip 

Problem: 

• TIE cannot determine which security is to be traded. 

Causes: 

• The sedol and the cusip refer to two different securities. 

• A share quantity matches a security identifier. 

Solution: 

1. Set the column containing the correct security identifier. 
2. Set the share column (share quantities may resemble security identifiers). 
3. Convert the order. 

Option: 

• Edit or replace the incorrect identifier and re-convert the order. 

Conflict: Sedol/Sicovam 

Problem: 

• TIE cannot determine which security is to be traded. 

Cause: 

• Two six-digit numbers match the sedol and sicovam of two different securities. 

Solution: 

1. Set the column containing the correct security identifier. 
2. Set the share column (six-digit shares may resemble security identifiers). 
3. Convert the order. 

Option: 

1. Edit or replace the incorrect identifier. 
2. Convert the order. 

Conflict: Sedol/Ticker 

Problem: 

• TIE cannot determine the security 

Cause: 

• The ticker and the sedol refer to two different securities. 

Solution: 

1. Set the column containing the correct identifier to give it precedence. 
2. Convert the order. 

Option 1: 

1. Edit the incorrect data so that it corresponds with the security.  
2. Convert the order. 
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Option 2: 

1. Delete the incorrect identifier. 
2. Convert the order. 

Conflict: Ticker/Cusip 

Problem: 

• TIE cannot determine the security. 

Cause: 

• The ticker and the cusip refer to two different securities. 

Solution: 

1. Set the column containing the correct identifier to give it precedence. 
2. Convert the order. 

Option 1: 

1. Edit the incorrect identifier so that it corresponds with the security to be traded. 
2. Convert the order. 

Option 2: 

1. Delete the incorrect identifier 
2. Convert the order. 

Conflict: Ticker/Side 

Problem: 

• TIE cannot determine if the data is a ticker or a side. 

Cause: 

• A string of characters matches a ticker as well as a side synonym. 

Solution: 

1. Cut or set the column containing the symbol with the conflict. 
2. Set the ticker or side columns when applicable. 
3. Convert the order. 

Conflict: Ticker w/RIC 

Problem: 

• TIE cannot determine the security 

Cause: 

• The ticker and the RIC refer to two different securities 

Solutions: 

1. Set the column containing the correct identifier to give it precedence. 
2. Convert the order. 

Option 1: 

1. Edit the incorrect data so that it corresponds with the correct security. 
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2. Convert the order. 

Option 2: 

1. Delete the incorrect identifier. 
2. Convert the order. 

Cusip Undefined 

Problem: 

• The cusip is not recognized. 

Causes: 

• Incorrect client data 

• Delisted cusip 

• Product database is incomplete 

Solution: 

1. Replace or edit the cusip so that it is correct. 
2. Convert the order. 

Found 2  

TIE™ reports when it finds duplicate security identifiers in an order row.  The simplest 
way to correct the problem is to set or cut one of the columns. 
 
Example: 

Found 2 Tickers 

Problem: 

• TIE cannot determine which ticker to use. 

Cause: 

• More than one piece of data in the row matches a ticker. 

Solution: 

1. Set or cut the columns indicated. 
2. Convert the order. 

Mismatch 

Problem: 

• The company name in the client list does not match company description in the 
database. 

Causes: 

• The company name listed and the identifiers given refer to two different securities. 

• The company name given and the name in the database differ in spelling.  

• The company name given and the name in the database differ in word order. 
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Solutions: 

If an incorrect security has been selected: 
1. Edit and correct the security identifiers. 
2. Convert the order. 

 
If a correct security has been selected: 

1. The message can be disregarded, since an order has been processed. 
2. Continue with the conversion. 
3. Convert the order. 

No Security 

Problem: 

• TIE does not detect a security. 

Causes: 

• No security has been identified. 

• The identifiers given are unknown. 

• The security has been delisted. 

Solution: 

1. Edit and correct any unknown identifiers.  
2. Set the security identifier column(s). 
3. Convert the order. 

No Shares 

Problem: 

• TIE cannot determine the share quantity. 

Causes: 

• No share quantity has been included in the row. 

• The share quantity has a decimal and is being interpreted as a price. 

• The share quantity resembles a security identifier (i.e. sedol, quick code). 

• The share quantity for every row is the same. 

Solution: 

1. Add the share quantity if it is missing. 
2. Set the share column. 
3. Convert the order. 

Odd Lot 

Trade Import Expert™ detects and reports odd lot share quantities.  When the number 
of shares being traded is not an exact multiple of the security's specified lot size, TIE™ 
warns the trader rather than preventing an order.  
 
Odd Lots for Japanese securities are displayed in the Status Column of the Tabular 
folder.  Odd Lots for  Japanese and all other securities are displayed in the Tabular 
folder's Status Bar when an individual row is clicked on, and are reported in the 
Comments field of the Total and "side" output folders.  A complete list of the odd lots, is 
found in the Trade Summary Report, and Odd Lot reports.   
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Security Comments 

The Security Comments warning is used to help notify traders of any product with 
special circumstances (i.e. - one that is illiquid - or, perhaps it's local ownership of 
shares for 'foreigners' is full. etc.).  It does not cause a kick out, but is printed on the 
upload reports for review and may cause the salesman to call the client and get 
something changed. 

Sedol Undefined 

Problem: 

• The sedol is not recognized. 

Causes: 

• Incorrect client data 

• Delisted sedol 

• Product database is incomplete 

Solution: 

1. Edit the sedol so that it is correct. 
2. Convert the order. 

Option: 

1. Replace the sedol with another security identifier. 
Convert the order. 

 
Note:  Columns previously “set” must be re-set and converted after editing. 

Set Side Manually Warning 

The Set Side Manually Warning is not an error, but a “safety net” feature; TIE prompts 
the user to discern and designate the side of the order when no side information given 
and the share quantities are all positive numbers. 
 

 
 
TIE™ will not assume the side of an order is “Buy” when no side has been indicated 
and all the shares are positive numbers.  In this situation TIE™ forces the user to set 
the side manually.  To do this, select a side by clicking on a Side Radio Button on 
TIE™’s Control Panel.  A dot will appear in the circle beside the side synonym.  Re-
Convert the order. 
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Symbol Undefined 

Problem: 

• The security has no internal security symbol. 

Causes: 

• Incorrect client data 

• Delisted ticker 

• Product database is incomplete 

• None of the identifiers are found in the product database 

Solution: 

1. Replace or edit the ticker so that it is correct. 
2. Replace or edit other identifiers so that one or all are correct. 
3. Set the column containing the corrected identifier. 
4. Convert the order. 

Option: 

1. Temporarily update the security data using the Security Reference dialog box. 
2. Edit or add the necessary security data. 
3. Click the Update button on the Security Reference dialog box. 
4. Click the Done button on the Security Reference dialog box to close it. 

Convert the order. 

Unknown Side 

Problem: 

• The abbreviation is not recognized. 

Causes: 

• Incorrect client data  

• The abbreviation is not a standard abbreviation 

Solution 1: 

1. Replace or edit the side so that it is correct. 
2. Convert the order. 

Solution 2: 

1. Temporarily add the side abbreviation(s) to TIE™'s side data, using the Side 
Reference dialog box. 

2. Convert the order. 
 

Note:  Columns previously “set” must be re-set and converted after editing. 

Unknown Account 

TIE™ recognizes client names and their accounts.  When TIE™ detects accounts in the 
trade list it automatically generates the allocations.  If information within a range of 
account names is not recognized as an existing client account, TIE™ will warn the user 
in one of two ways: 
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• If the account names are listed horizontally across a page, TIE™ will generate a 
“Cut or set column with account….” message, indicating the column in question. 

• When the accounts are listed vertically in a column, on consecutive rows, TIE™ will 
generate an “Unknown Account” message for any row that has an unrecognized 
account name in the account column. 

Problem: 

• Information that appears to be an account is not found in the client account data in 
the database.  

Causes: 

• The account is new 

• The account is missing from the database  

• The information is not an account 

Solutions: 

If a column is in question, cut or set the column and reconvert. 
If a cell is in question, set the cell or the column containing the cell and reconvert the 
order. 
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12.  PROBLEM SOLVING SCENARIOS 

Merged Data 

Problem: 

There is no separation between data items.  The order cannot be converted because 
some significant data is merged with other data. 
 
Do you have something that looks like this? 
 

 
 
That is because the client’s input data looked like this… 
 

 
 

Solution: 

It’s not a problem.  All you have to do is bisect the columns to separate the data and 
reconvert the order. 
 
1.  Place a field delimiter to create two separate columns. Position the cursor on the 
header bar, over the closest field delimiter to the right of where you will be placing the 
new one. When the cursor becomes a double arrow with a horizontal line running 
through it, hold down the Control key and then press the left mouse button and drag the 
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field delimiter to the left.  This action creates a new field delimiter.  Release the left 
mouse button when the new field delimiter is positioned where you want it.  
 
In the following example a field delimiters have been placed so that they bisect the 
formerly merged data. 

 
(Field delimiters are created when dragging to the left, only; dragging field delimiters to 
the right merges columns). 
 
2.  Reconvert the order.  Click on the Convert button to process the new data. 
 

Merged Data with No Clear Division Point 

Problem: 

There is no separation between data items.  The order cannot be converted because 
significant data is merged with other data, and the alignment of the data leaves no clear 
division point for a column bisect. 
 
Do you have something that looks like this? 
 

 
 

Solution: 

It’s not a problem.  You need to create columns by dragging in field delimiters to 
separate the data and reconvert the order.  For data that does not line up correctly, the 
simple trick of realigning the data from left to right, or right to left as you go, will create 
the justified edges you need in order to place a field delimiter. 
 
1.  Select the column. Click on the column header to highlight the entire column. 
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2.  Realign the data.  Hold down the Control key on your keyboard and click the right 
mouse button. 
 

  
3.  Place a field delimiter to create two separate columns. Hold down the Control 
key and position the cursor on the header bar, over the closest field delimiter to the right 
of where you will be placing it.  When the cursor becomes a double arrow with a 
horizontal line running through it, press the left mouse button and drag the field 
delimiter to the left.  This action creates a new field delimiter.  Release the left mouse 
button when the new field delimiter is positioned where you want it.  
 

 
 (Field delimiters are created when dragging to the left.  Dragging field delimiters to the 
right merges columns). 
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Multiple Conflicts 

Problem: 

The order has conflicts on every row and setting one or two columns doesn’t get rid of 
them. 
 
Do you have something that looks like this? 
 
 

 

Solution: 

You can follow the error message instructions and set and cut columns until all conflicts 
are resolved or you can take pro-active measures with files that contain many columns 
of data by consolidating your data (the more concise the file, the faster the conversion). 
1. Look the file over initially and cut all unneeded columns. 
2. Set any accounts. 
3. Convert the order. 
This is the fastest way to convert a “busy” file. 
 
Keep in mind if you want a column such as “section type” in the pictured example, 
above, to appear in Trade Execution System upload results, you can set the column as 
a memo by highlighting the column and clicking on the Set Memo button, then clicking 
on the Convert button.  Setting or cutting this column will prevent possible side and 
ticker conflicts (“CS” pictured in the “section type” column, above, is both a known side 
and a known ticker). 
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No Columns 

Problem: 

The order to be converted has no columns. 
 
Do you have something that looks like this? 
 

 
 

Solution: 

It’s not a problem.  You will have to create columns by dragging the far right field 
delimiter to the left, and then re-dragging each placed delimiter, creating new delimiters, 
across the screen from one placement point to the next.  
 
1.  Create a field delimiter.  Hold down the Control key on your keyboard.  Position the 
cursor on the far right edge of the header bar until it the cursor arrow becomes a double 
arrow with a horizontal line running through it.  Press the left mouse button and drag the 
field delimiter to the left. This action creates a new field delimiter.  Release the left 
mouse button when the field delimiter positioned where you want it. 
 

 
 
2.  Create and place a new field delimiter.  Hold down the Control key again. Position 
the cursor on the header bar, over the closest field delimiter to the right of where you 
will be placing the new delimiter.  When the cursor arrow becomes a double arrow with 
a horizontal line running through it, press the left mouse button and drag the field 
delimiter to the left. Release the left mouse button when the new field delimiter 
positioned where you want it. (Field delimiters are created when dragging to the left, 
only; dragging field delimiters to the right merges columns). 
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3.  Continue the same steps until all necessary field delimiters are in place. 
 

 
 
4.  Convert the order. 
 

 



Trade Import Expert�   Chapter 12: Problem Solving 

Software Intelligence, Inc. © 2001 98

Parallel Orders 

Problem: 

Orders are listed in parallel columns.  TIE™ is reading two security identifiers, two 
company names, and two share quantities on every order row, and is unable to convert 
the file. 
 
Do you have something that looks like this? 
 

 
 

Solution: 

It’s not a problem.  You will have to convert this order in two passes.   
 
1. Highlight the first three columns of "Buy" order information. 
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2. Click on the Convert button to convert the orders. 
 

 
 
3. Upload the orders. 
 
Process the second section of the trade list the same way: 
4. Highlight the second set of three columns of "Sell" order information. 

 

 
 
5. Click on the Convert button to convert the orders. 
6. Upload the orders. 
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13.  REFERENCE DIALOG BOXES 

Account Reference 

The Account Reference dialog box allows the user to look up accounts by client, to look 
up specific account names, and to add, delete and update account information. 
 
To access the Account Reference dialog box, click on the button marked “ACCT REF” 

on the toolbar  or highlight and click on “Account Reference” in the right-click 
popup menu. 
 

 
The Account Reference is organized to include a list box of clients, a list box for 
findings, and edit controls for both External Account Mnemonics and Internal Account 
Numbers. 
 

Searching by Account Name 

1. Type an account name into the External Account Mnemonic edit control. 
2. Click on the “Find” button. 

 

Searching by Internal Account Number 

1. Type an internal account number in the Internal Account Number edit control. 
2. Click on the “Find” button. 

 

Searching by Client 

1. Select a client by scrolling through the client list and double clicking on a client name.  
The client’s name will appear in the Client Name edit control. 
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2. Double click again on the client name, and the client’s accounts will appear in the 
External Account Mnemonic list box. 

3. Scroll through the list and double click on any account name to view its external 
account mnemonic and internal account number.  The client’s account information for 
the selected account will be displayed in the External Account Mnemonic and Internal 
Account Number edit controls. 

Adding an Account 

1. Select a client by scrolling through the client list and double clicking on a client name.  
The client’s name will appear in the Client Name edit control. 

2. Type the account name to be added in the External Account Mnemonic edit control. 
3. Type the corresponding internal account number in the Internal Account Number edit 

control. 
4. Click on the “Add” button. 

 

Deleting an Account 

1. Find the account, using any one of the search methods listed above. 
2. Double click on the account in the External Account Mnemonic list box.  The account 

information will be displayed in the External Account Mnemonic and the Internal 
Account Number edit controls. 

3. Click on the “Delete” button. 

Updating an Account 

1. Find the account, using any one of the search methods listed above. 
2. Double click on the account in the External Account Mnemonic list box.  The account 

information will be displayed in the External Account Mnemonic and the Internal 
Account Number edit controls. 

3. Edit the Account Mnemonic and/or the Internal Account Number. 
4. Click on the “Update” button. 

 
Changes made are saved up until the time reference data is refreshed.  Permanent 
changes must be referred to the department that handles updating the database. 
 

Clearing the Edit Controls 

Click on the Clear button. 
 

Closing the Dialog Box 

Click on the Done button or the “X” button located in the upper right corner of the dialog 
box. 
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Client Reference 

The Client Reference dialog box allows the user to search for, verify, add, and delete 
client names and Ids. 
 
To access the Client Reference dialog box, click on the button marked “client REF” on 

the toolbar  or highlight and click on “Client Reference” in the right-click popup 
menu. 
 

 
 
The Client Reference is organized with a scrolling list box and an edit control for the 
Client ID and an edit control for the Client Name. 

Searching for a Client 

1. Scroll through the Client ID list box. 
2. Highlight and double click on the client ID. 

Adding a Client 

1. Type a two to four-character client ID in the Client ID edit control. 
2. Type the corresponding client name in the Client Name edit control. 
3. Click on the Add button. 

 
If the client ID is already being used, TIE™ will not be able to add the new ID and 
client.  Check the Status Bar after clicking on the Add button for confirmation that the 
new client has been added. 

 
Note: If TIE™ is restarted or the data is refreshed, changes made by the user will be lost.  
Permanent changes (additions and deletions) must be made directly to the database.  These 
features are intended to speed up the conversion process for traders when there is no time to 
wait for database corrections. 

Deleting a Client 

1. Scroll through the Client ID list box. 
2. Highlight and double click on the client ID of the client to be deleted. 
3. Click on the Delete button. 
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Clearing the Edit Controls 

 Click on the Clear button. 
 

Closing the Dialog Box 

Click on the Done button or the “X” button located in the upper right corner of the dialog 
box. 

Country Reference 

The Country Reference dialog box allows the user to search for, verify, add, update and 
delete country abbreviations, regions, commission rates, tax rates, and clearing fees. 
 
To access the Country Reference dialog box, click on the button marked, “CTRY REF” 

on the toolbar  or highlight and click on “Country Reference” in the right-click 
popup menu. 
 

 
The Country Reference dialog box includes a scrolling list box of country abbreviations 
and edit controls for the country abbreviation, country name, region code, commission 
rate, buy tax rate, sell tax rate, and clearing fee. 
 
The Country Reference displays the data used to compute transaction fees in the Bid 
folder. 
 

Searching for a Country 

1. Scroll through the Country Code list box. 
2. Click on the country abbreviation. 
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Adding a Country 

1. Type a country abbreviation in the Country Code edit control at the top of the dialog 
box. 

2. Type the country name in the Description edit control. 
3. Enter any fees or rates in the appropriate edit controls. 
4. Click on the Add button. 

Updating Regions, Rates and Fees 

1. Edit the region, rate, or fee. 
2. Click on the Update button. 

Deleting a Country 

1. Scroll through the Country Code list box. 
2. Click on the country abbreviation for the country to be deleted. 
3. Click on the Delete button. 

Clearing the Edit Controls 

Click on the Clear button. 

Closing the Dialog Box 

Click on the Done button or the “X” button located in the upper right corner of the dialog 
box. 

Foreign Exchange Reference 

The Foreign Exchange Reference (FX Reference) dialog box allows the user to search 
for, confirm, or revise exchange rates for foreign currencies. 
 
To access the Foreign Exchange Reference (FX Reference), click on the button 

marked, “FX REF” on the toolbar  or highlight and click on  “FX Reference” in the 
right-click popup menu. 
 

 
The Foreign Exchange Reference dialog box includes a scrolling list box of currency 
codes, and edit controls for the currency abbreviation (Currency*), the exchange rate 
(FX Rate), the country (Description), and the type of exchange (Type). 
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Searching for a Currency 

1. Scroll through the Currency list box. 
2. Highlight and click on the currency abbreviation 

 

Adding a Currency 

1. Type the currency abbreviation into the Currency edit control. 
2. Type the foreign exchange rate into the FX Rate edit control. 
3. Type the country name into the Description edit control. 
4. Type “multiply” or “divide” as the conversion type into the Type edit control. 
5. Click on the Add button. 

Deleting a Currency 

1. Scroll through the Currency list box. 
2. Highlight and click on the currency abbreviation in the list box. 
3. Click on the Delete button. 

Clearing the Edit Controls 

Click on the Clear button. 

Closing the Dialog Box 

Click on the Done button or the “X” button located in the upper right corner of the dialog 
box. 

Security Reference 

The Security Reference dialog box allows the user to search for, add, delete, and 
update security information. 
 
To access the Security Reference, click on the button marked, “SEC REF” on the 

toolbar   or highlight and click on “Security Reference” in the right-click popup 
menu. 
 
The Security Reference displays the following information based on the data available 
in the database: Ticker/Quick Code, Cusip, RIC, Sedol, Canadian RIC, Canadian 
Sedol, Sicovam, Kassenverein, Valoren, ISIN, Price, Country, Issuer, Currency, 
Exchange, Restricted, Security comments, and Lot size.  A Company Search edit 
control allows for searches by company name, and a Company List list box displays all 
matching companies.  Scroll bars appear when the list exceeds the display area of the 
list box. 
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Edit Controls with an asterisk* 

In the Security Reference dialog box only the edit controls marked with an asterisk may 
be used for searching.  (All Security Reference fields may be updated.) 

Searching by Company 

1. Type the company name in the Company Search edit control. 
2. Click on the Find button. 

Company Search Options 

Several options can broaden or narrow the company search: 
 
A. The user can type the first word or just the first letters of a company name. 

B. The user can click the radio button for Contains to find all company names that 
contain a particular word or group of characters. 

C. The user may click the radio button for Begins to limit the findings to company 
names that begin with a particular word or group of characters. 

D. The user may click the radio button for Equals to limit the findings to only those 
companies whose name is an exact match to what the user has typed. 

E. The user may also limit the search to companies found within a particular country.  
To do this the user clicks on the down arrow button on the Country list box to select 
a country code, and then proceeds with one of the company search methods, 
above. 

Searching by a Security Identifier 

1. Type or paste a security identifier into its corresponding edit control. 
2. Click on the Find button. 

Please note that the RIC edit control is case sensitive. 

Updating Security Information 

All of the displayed security data may be updated. 
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1. Find the security to be updated. 
2. Type or paste changes into the appropriate edit control(s) 
3. Click on the Update button. 

Adding a Security 

The minimum data required to add a security is a ticker, cusip, or sedol, an A client’s 
internal security symbol, and a country code. 
 
1. Type or paste the security identifier into the appropriate edit control. 
2. Type or paste the country code into the Country edit control. 
3. Type or paste any other security data into the appropriate edit controls. 
4. Click on the Add button.  

Deleting a Security 

1. Find the security to be deleted. 
2. Click on the Delete button. 

Clearing the Edit Controls 

Click on the Clear button. 

Closing the Dialog Box 

Click on the Done button or the “X” button located in the upper right corner of the dialog 
box. 
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Set Client Dialog Box 

The Set Client dialog box serves the primary purpose of assigning a client name to the 
order file being converted, it has the secondary function of allowing a user to set a 
default account when all orders in a list will be part of one account.   
 
The Set Client dialog box pops up automatically when a new file is opened. It can be 
used like a reference dialog box providing the user with the following reference 
capabilities: searching for a client mnemonic, displaying a client’s ID, searching for 
accounts: by client, by external account mnemonic, and by internal account number, 
adding and deleting clients, adding and deleting accounts, and setting and clearing 
default accounts. 
 
When the user “sets” a client, the client name will appear along with the file name in 
TIE™’s header bar. The client name will also be pre-selected in the upload dialog box 
when uploading the order into the trading system.  In addition, TIE™ will automatically 
identify known client accounts in a list. When the account names are unique TIE™ will 
identify the accounts and convert the order with sub-account allocations. 
 

To access the Set Client dialog box, click on the Set Client button  or highlight 
and click on “Select Client” in the right-click popup menu. 
 

 

Setting a Client 

1. Scroll through the Client list box; highlight and click on a client name. 
2. Click on the Set Client button. 

Adding a Client 

1. Type a client ID in the Client ID edit control. 
2. Type the client name in the Client Name edit control to the right of the Client ID. 
3. Click on the Add Client button. 

Viewing a Client’s Accounts 

1. Scroll through the Client list box; highlight and click on a client name. 
2. If the client has accounts in the database, they will be displayed in the Account list box.  
3. To view an account’s internal account number, highlight and click on the account name 

in the Account list box. 
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Searching by Account Mnemonic 

1. Check that no client is selected.  The Client edit control should be clear.  If a client 
name is highlighted, click on the Clear button. 

2. Type or paste an external account mnemonic into the External Account Mnemonic edit 
control. 

3. Click on the Find button. 
4. All accounts with that mnemonic will be displayed in the Account list box, followed by a 

separator line and a client ID.  Click on any of the account listings to view its internal 
account number and client information. 

Searching by Internal Account Number 

1. Check that no client is selected.  The Client edit control should be clear.  If a client 
name is highlighted, click on the Clear button. 

2. Type or paste an internal account number into the Internal Account Number edit 
control. 

3. Click on the Find button. 
4. If an account with that internal account number is found, the client name will be 

highlighted in the Client list box, and the external account mnemonic will be displayed 
in the External Account Mnemonic edit control. 

Adding an Account 

1. Select and set the client. 
2. Enter the account name in the External Account Mnemonic edit control. 
3. Enter the internal account number in the Internal Account Number edit control, or leave 

it blank. 
4. Click on the Add Account button. 

Setting a Default Account 

1. Select the client by highlighting and clicking on the client name in the Client list box. 
2. Select a client account by highlighting and clicking on the account name in the 

Account list box. 
3. When the account is selected, click on the Set Default Account button. 
4. Type and account name into the Default account edit control and click Set Default 

Account. 

Clearing a Default Account 

1. Select the client by highlighting and clicking on the client name in the Client list box. 
2. Select the client account by highlighting and clicking on the account name in the 

Account list box. 
3. When the account is selected, click on the Clear Default Account button. 
4. Reconvert the order. 

or 
1. If the default account already appears in the edit control, simply click on the Clear 

Default Account button. 
2. Reconvert the order. 

Clearing the Edit Controls 

Click on the Clear button. 

Closing the Dialog Box 

Click on the Done button or the “X” button located in the upper right corner of the dialog 
box. 
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Side Reference 

The Side Reference dialog box is used to find, add, and delete side synonyms. A side 
synonym is a word or set of words, which TIE recognizes as a side.  TIE translates side 
synonyms into one the seven fundamental sides: buy, sell, buy cover, sell short, buy on 
a down tick, sell on an up tick, and short exempt. 
 
To access the Side Reference dialog box, click on the button marked, “SIDE REF” 

 or highlight and click on “Side Reference” in the right-click popup menu. 
 

 
The Side Reference provides a list box of the side synonyms TIE™ recognizes and a 
list box displaying the fundamental sides.  The Synonym edit control enables the user to 
add additional side synonyms. Descriptions of the seven primary side abbreviations are 
displayed in the lower right corner of the dialog box. 

Searching for a Side Synonym 

1. Type a synonym into the Synonym edit control or scroll through the Synonym list box. 
2. Click on the synonym to see its corresponding side displayed in the Side edit control. 

Adding a Side Synonym 

1. Type or paste the synonym to be added into the Synonym edit control. 
2. Highlight and click on the corresponding side abbreviation in the Side list box. 

Deleting a Side Synonym 

1. Highlight and click on the synonym to be deleted in the Synonym list box. 
2. Click on the Delete button. 

Clearing the Edit Controls 

Click on the Clear button. 

Closing the Dialog Box 

Click on the Done button or the “X” button located in the upper right corner of the dialog 
box. 
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14.  UPDATING DATA 

Additions, Deletions and Updates 

 
Reference dialog boxes facilitate speedy revisions when instant results are needed.  
Additions, deletions and updates are only temporary and only effect the single user’s 
application. If TIE™ is restarted or the data is refreshed, changes made by the user will 
be lost.  Permanent changes must be made directly to the database.  These features 
are intended to speed up the conversion process for traders when there is no time to 
wait for database corrections. 
 
If data being added or updated already exists in the database, TIE™ cannot add or 
update the data without the user deleting an existing duplication, first.  Check the Status 
Bar after clicking on the Add or Update buttons for confirmation that data has been 
successfully added or updated. 

Adding Accounts 

The user may add external account mnemonics and internal account numbers in the 
Set Client dialog box or the Account Reference dialog box.  

To add an account using the Account Reference dialog box: 

Open the Account Reference dialog box by clicking on the button marked Acct Ref. 
1. Select a client name from the Client list box by clicking on it.  
2. Type an account name in the External Account Mnemonic edit control. 
3. Type an internal account number in the Internal Account Number edit control 
4. Click on the Add button.  

To add an account using the Set Client dialog box: 

1. Open the Set Client dialog box by clicking on the button marked Set Client. 
2. Select a client from the Client List box and click on it. 
3. Enter the account name in the External Account Mnemonic edit control. 
4. Enter the internal account number in the Internal Account Number edit control. 
5. Click on the Add Account button. 

Adding Client Names 

The user may temporarily add client names and client IDs using the Set Client dialog 
box or the Client Reference dialog box.   

To add a client using the Client Reference dialog box: 

1. Open the Client Reference dialog box by clicking on the button marked Client Ref. 
2. Type a client ID in the Client ID edit control.  (Client IDs should be between two and 

four characters in length.) 
3. Type the corresponding client name in the Client Name edit control. 
4. Click on the Add button. 

To add a client using the Set Client dialog box: 

1. Open the Set Client dialog box by clicking on the button marked Set Client. 
2. Type a client ID in the Client ID edit control. (Client IDs should be between two and 

four characters in length.) 
3. Type the client name in the Client Name edit control to the right of the Client ID. 
4. Click on the Add Client button. 
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Adding Securities 

Securities can be added using the Security Reference dialog box. The minimum data 
required to add a security is an unused ticker, cusip, or sedol and a country code.  
Foreign securities must also include an unused A client’s internal security symbol. 
1. Open the Security Reference dialog box by clicking on the button marked Sec Ref. 
2. Type or paste the security identifier into the appropriate edit control. 
3. Type or paste the country code into the Country edit control. 
4. Type or paste other security data into the appropriate edit controls. 
5. Click on the Add button.  

Updating Account Information 

Account information such as account names and internal account numbers can be 
updated using the Account Reference dialog box.   
 
1. Open the Account Reference dialog box by clicking on the button marked Acct Ref. 
2. Select a client name from the Client list box by clicking on it.  
3. Select the client account from the External Account Mnemonic list box by clicking 

on it. 
4. Edit the information that appears in the External Account Mnemonic and Internal 

Account Number edit controls.  
5. Click on the Update button for existing information to be revised. 

Updating Commissions, Taxes, and Clearing Fees 

To make changes to commissions, taxes or clearing fees, use the Country Reference 
dialog box.  Edit the information to be updated and click on the Update button.  The 
temporary changes will be saved until the reference data is refreshed or the application 
is closed and restarted. 

Updating Exchange Rates 

Exchange rates are stored in the TIE™ Input Directory in a file called fxrate.txt.  To 
update the exchange rates that TIE™ displays in the Foreign Exchange (FX) Reference 
and for all its conversion calculations, the fxrate.txt file must be edited and the changes 
saved.  This file is updated nightly.  To have changes made to this file contact the 
person in charge of data management. 
 
To refresh TIE™’s reference data, go to Tools in the menu bar and click on Refresh 
Reference Data.  This process can take as long as restarting TIE™, so it is 
recommended that this not be done during heavy trading activity. 

Updating Security Data 

The Security Reference dialog box is used to temporarily update security data.  All data 
displayed in the edit controls of the Security Reference can be updated. 
 
1. Open the Security Reference dialog box by clicking on the button marked Sec Ref. 
2. Find the security to be updated. 
3. Type or paste changes into the appropriate edit control(s) 
4. Click on the Update button. 
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Updating Prices 

If the Total folder contains a price of zero for a security it is due to a missing price in the 
database.  The Total folder displays the prior night's closing prices from the database, 
unless client reference prices are provided.  

Editing a client Reference Price: 

A client reference price may be edited in the Excel™, Tabular, or Total folders, and the 
editing change will be reflected in all reference price calculations in the Total, Side, 
Country and Report folders. 
 
When a price is edited in an Input folder (the Excel™ and Tabular folders are Input 
folders) then the user must click on the Convert button, to process the changes.  Once 
converted, the totals in the Output and Report folders will reflect the new price 
information. 
 
When a price is edited in the Total folder (which is an Output folder) it is not necessary 
to re-convert the order.  The changes are immediately processed and reflected in the 
other Output and Report folders as soon as the user tabs out of the edited cell. 
 
Note: Re-converting the order will re-process the data from the Tabular folder, eliminating 
changes made to the data in the Total folder. 

Editing a Zero Closing Price: 

A zero closing price may be temporarily modified using the Security Reference dialog 
box. 
 

1. Open the Security Reference dialog box, by clicking on the button marked Sec Ref. 
2. Find the security by entering an identifier into one of the security identifier edit 

controls and clicking on the Find button.  
3. Type the new price in the Price edit control.  
4. Click on the Update button.   

 
Note: 

 

• A notice should appear in the Status Bar that the security has been updated.   

• After the security is updated, the user must reconvert the order.  The new closing price will be 
reflected in the closing principals in the Country, Total, Side, Bid, and Report folders, once the 
order has been re-converted. 

• Remember that these on-the-fly changes are only temporary; if TIE™ is restarted or the 
reference data is refreshed, prior-editing changes made by the user will be cleared.  
Permanent changes must be made directly to the database. 
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15.  TECHNICAL INFORMATION 

Implementation 

The Trade Import Expert™ is a Microsoft Foundation Class (MFC 4.0) multiple 
document interface (MDI) application written entirely in C++ with MSVC 6.0. It uses 
RogueWave Tools.h++ Version 7.09, the Formula One Version 6.0 from TideStone 
Technologies, Objective Grid 7.0 from RogueWave/Stingray Software, Objective Toolkit 
6.0 from RogueWave/Stingray Software, Objective Edit 6.0 from RogueWave/Stingray 
Software and Component Toolbox OCX v3.0 from DBI Technologies.  The parsing 
algorithms were invented and implemented by Software Intelligence, Inc., with patents 
pending. 
 

Minimum Hardware/Software Requirements 

200 Pentium Processor or greater 
128 megabytes RAM (based upon including 50,000 tickers & 1,000 client accounts). 
Virtual Memory – 256 megabytes (based upon including 50,000 tickers & 1,000 
accounts). 
Windows NT 4.0 Service Pack 3 or greater 
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QUICK REFERENCE – KEY STROKES 

 

 

Function   Key sequence 

 

Alignment   CONTROL + RIGHT CLICK 

Copy    CONTROL + C 

Cut    CONTROL + X 

FastFind   SHIFT + RIGHT CLICK 

Paste    CONTROL + V 

Sort    CONTROL + LEFT DOUBLE CLICK  

Transpose   SHIFT + LEFT DOUBLE CLICK    

TIE™ menu   RIGHT CLICK 
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GLOSSARY 
 

account by range -  Account by range processing refers to processing account 
names when they are listed as headings preceding a group of 
securities. All securities listed following an account heading will 
display allocations for that account. 

 
Account Reference -  The Account Reference is a dialog box that allows the user to 

look up all the accounts for a particular client, to look up specific 
account names, and to add, delete and update account 
information. 

 
alert -    In TIE™, alert refers to the alert lights on the control panel. 

�� The Security Alert lets the user know if there are any 
unknown security identifiers in a list.   

�� The Conflict Alert lets the user know if there are securities 
in a list that have not been converted into orders due to data 
conflicts.   

�� The Price Alert indicates whether the prices given in a list 
are +/- 5% over or under the prior night’s closing price.   

�� The Allocation Alert indicates sub-account allocation 
imbalances, and will only be lit when sub-accounts are 
present in a list. 

 
Allocation Alert - The Allocation Alert is one of four Alert Lights located in TIE™'s 

Control Panel, to the right of the grid. The Allocation Alert 
indicates sub-account allocation imbalances, and will only be lit 
when sub-accounts are present in a list. 

 
A green LED indicates the accounts reconcile.  A gray LED 
means that the alert is not applicable.  A red LED indicates the 
accounts do not reconcile. 

 
attribute - In TIE™, the word attribute refers to characteristic data or criteria 

including: security identifiers, share quantities, memos, etc. 
   

cell - In a data grid, a cell is an individual compartment of any size in 
which data can be entered; it is designated by borders on four 
sides.  A row can be comprised of many cells or the entire row 
can be one cell, depending upon how the grid has been 
formatted.  A column consists of cells in consecutive rows that 
line up one on top of the other. 

 
client ID - A client ID, or client identifier, is the internal abbreviation or code 

assigned to a client.  Client IDs are used to look up client names 
and client account information.  The client ID is a two to four-
character mnemonic.  TIE™'s dialog boxes list clients by client 
ID, followed by the client name. 

 



Trade Import Expert�   Glossary 

Software Intelligence, Inc. © 2001 117

Client Reference - The Client Reference is a dialog box that allows the user to 
search for, verify, add, and delete client names and IDs. 

 
columnized input - Columnized input is client data that has been organized into 

columns. Trade Import Expert™  determines where columns 
should be placed during the initial conversion process when an 
order is opened in TIE.  The columnized input can be viewed in 
the Tabular  folder.  

 
conflict - In TIE™, conflict refers to discrepancies or ambiguities in 

security data.  
 
Example:  When two identifiers given for one security don’t 
match the same security, it creates a conflict. The would-be 
order will have a conflict message in the Status Column of the 
Tabular folder letting the trader know to check, resolve, or 
designate the data. 

 
Conflict Alert - The Conflict Alert is one of four Alert Lights located in TIE™'s 

Control Panel, to the right of the grid. The Conflict Alert lets the 
user know if there are securities in a list that have not been 
converted into orders due to data conflicts.   

 
A green LED indicates no conflict.  A gray LED means that the 
alert is not applicable.  A red LED indicates a conflict. 

 
convert - In TIE™, convert means to interpret input data and process an 

order which can be uploaded to a trade execution system.   
 

Each time the user sets columns or edits data, these changes 
become new input to be read by the computer; thus after data 
has been edited, added, deleted or designated by a set feature, 
the order must be reconverted.  When an order is successfully 
converted the status of the security row in the Tabular folder will 
read, “Order,” and the order data will be visible in the subsequent 
folders. 

 
Country Reference - The Country Reference is a dialog box that allows the user to 

search for, verify, add, and delete country abbreviations. 
 

cusip - A cusip is a unique security identifier for US and Canadian 
securities.  A cusip is eight digits followed by a ninth check digit.  
TIE™ recognizes both eight and nine digit cusips. TIE™ also 
recognizes seven digit cusips by pre-pending a leading zero 
character. 
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cut - In TIE™, cut means to permanently remove data from the grid. 
Cut differs from delete in that delete removes just the data from 
within cells, rows, or columns, where cut removes the entire 
selected cell and its associated column, selected row, or 
selected column. 

 
In word processing, data that is cut is temporarily moved to a 
clipboard, making it possible to reinsert the data using a “paste” 
feature. Data that has been cut is temporarily saved only until a 
new cut or copy operation has replaced it with new data. In word 
processing cut differs from delete in that delete permanently 
removes the data, where cut gives the user the option of 
removing it and relocating it or putting it back. This is not true, 
when working in a data grid in TIE™.  In a data grid, cut 
permanently removes the data and its compartments. 

 
delete - To delete means to permanently remove.  In TIE™, delete 

removes data from within cells, rows, and columns.  Delete 
differs from cut in that delete removes just the data from within 
cells, rows, or columns, where cut removes the entire selected 
cell and its associated column, selected row, or selected column. 

 
errors - In Trade Import Expert™ , “error” refers to conflicts and other 

discrepancies that prevent a security listing from being converted 
into an order.  (For example: the security identifier may be 
unknown or there may be missing shares.)  Specific error 
messages may be looked up under the section titled “Error 
Messages.” 

 
exchange -   A marketplace for the trading of financial instruments. 

 
Examples:  
Exchange   Abbreviation Suffix/Exchange Code 
New York Stock Exchange  NYSE   N    
American Stock Exchange AMEX  A 
National Association of Securities Dealers Automated Quote System 

NASDAQ  O or OB 
Toronto Stock Exchange TSE  TO 
London Stock Exchange LSE  L 

 
external account mnemonic -  An external account mnemonic is a client account name.   

 
Foreign Exchange Reference - The Foreign Exchange Reference (FX Reference) is a dialog box 

that allows the user to search for, confirm, or revise exchange 
rates for foreign currencies. 

 
internal account number - An internal account number is an in-house account number that 

has been assigned to a client’s account. 
 

ISIN - An ISIN is an international security identifier.  Every ISIN begins 
with a country code, and then contains a string of numbers 
ending with a check digit.  In the case of US securities, the ISIN 
is usually comprised of the country code, the cusip, and a check 
digit. 

 
kassenverein -   A kassenverein is a six digit German security identifier. 

 



Trade Import Expert�   Glossary 

Software Intelligence, Inc. © 2001 119

odd lot - An odd lot is any number of shares which is not an exact multiple 
of a round lot and therefore has a remainder. The lot size is the 
number of shares of a security that an exchange is supposed to 
trade.  A round lot is an exact multiple of the lot size (usually 
100, or 1,000).   

 
Price Alert - The Price Alert is one of four Alert Lights located in TIE™'s 

Control Panel, to the right of the grid. The Price Alert indicates 
whether the prices given in a list are +/- 5% over or under the 
prior night’s closing price.   

 
A green LED indicates that the client reference prices are near or 
match the closing prices.  A gray LED means that the alert is not 
applicable.  A red LED indicates that one or more of the client's 
reference prices is off by plus or minus 5% or more.    

 
quick code - A quick code is a Japanese security mnemonic, or identifier.  A 

quick code is four digits in length. 
 

range - In Trade Import Expert™, a range refers to a selection of 
consecutive rows of data. Highlighting a group of consecutive 
rows in a list is selecting a range of rows.  

 
Range Edit Controls - The Range Edit Controls are located on Trade Import Expert™’s 

Control Panel to the right of the grid.  The edit controls allow a 
trader to specify line numbers and convert only the rows of 
security data between and including those two rows. 

 
Ric -  Reuters Interchange Code. The RIC usually consists of the 

ticker, a dot, and the exchange the security trades on as a suffix.  
Preferred securities and class A-Z securities include additional 
codes, such as _p, _a-_z (Example: IBM_p.N).   
Note: RICs are case specific. TIE™'s edit controls and 
conversions of RICs are case sensitive. 

 
Security Alert - The Security Alert is one of four Alert Lights located in TIE™'s 

Control Panel, to the right of the grid. The Security Alert lets the 
user know if there are unknown security identifiers in a list.   

 
A green LED indicates the data in a list is identified, and trades 
listed have been converted into orders.  A gray LED means that 
the alert is not applicable.  A red LED indicates security data that 
is not recognized or converted. 

 
security ID - The security ID or security identifier in Trade Import Expert™ ™  

refers to the data used to identify a security during the 
conversion and uploading of an order.  

 
When a trade list is uploaded, security identifiers that have been 
“set” specifically as Security ID (as opposed to ticker, sedol, etc.) 
will override all other identification criteria in the list.  This 
enables the user to be able to upload data that TIE™ does not 
recognize as an identifier (identifiers not found in the database).   

 
Security Reference - The Security Reference is a dialog box that allows the user to 

search for, add, delete, and update security information.   
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sedol - A sedol is a security identifier issued by the London Stock 

Exchange.  A sedol is six digits in length, sometimes followed by 
a seventh check digit.  TIE™ recognizes both six and seven digit 
sedols. 

 
side by range -  Side by Range processing refers to processing sides when they 

are listed has headings preceding groups of securities. All 
securities listed following a side heading will be converted to that 
side. 

 
Side Reference -  The Side Reference is a dialog box that allows the user to 

search for, confirm, and temporarily add side abbreviations. 
 

side synonym - A side synonym is a side abbreviation.  Common side synonyms 
are recognized by TIE™ and included in the Side Reference 
dialog box. 

 
ticker - A ticker is the mnemonic under which a security trades on a US 

stock exchange.  Tickers are three characters long on the NYSE 
and up to 5 characters on the NASDAQ. 
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INDEX 
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account by range, 116 
account processing, 116 
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Account Report, 4, 67, 75, 76 
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Advanced Features, 2, 14, 15, 19, 32, 34, 

35, 40, 48 
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Alert Lights, 2, 4, 33, 39, 75, 116, 117, 119 
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Bisecting Columns, 2, 21, 23 
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Canadian Security Processing, 14, 34 
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Conflict, 4, 33, 75, 82, 83, 84, 85, 86, 116, 

117 
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Convert, 7, 8, 9, 12, 13, 15, 16, 17, 18, 19, 
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Copy, 2, 3, 7, 21, 24, 36, 53, 115 
Copy and Paste, 7 
Correcting Errors, 2, 9 
Country Folder, 4, 22, 51, 61 
Country Reference, 3, 5, 9, 36, 37, 45, 53, 

103, 112, 117 
Cut, 3, 8, 11, 22, 24, 37, 53, 82, 83, 86, 91, 

115, 118 
Cutting and Deleting, 22, 24 

D 

Daily Summary Report, 3, 4, 31, 37, 41, 66, 
69 

Data Refresh, 3, 38 
Default account, 47, 54, 108, 109 
Default Account, 109 
Display Allocation Detail, 3, 38 
Drag and Drop, 7 
Dually Listed Processing, 2, 14, 34, 35 
Dually Listed Security Processing, 14, 34 
Dually Listed Warning, 4, 75 
Dummy accounts, 44, 74 
Duplicate Account, 76 
Duplicate Internal Accounts Warning, 4, 75 
Duplicate Security per Account Warning, 4, 

76 

E 

Editing, 2, 3, 13, 15, 21, 22, 23, 24, 26, 27, 
39, 58, 64, 113 

Entering an Order, 2, 28 
Entering an Order Manually, 2, 28 
Error Detection, 2, 4, 33, 39, 75, 116, 117, 

119 
Error Messages, 4, 33, 50, 82, 118 
Error Reporting, 3, 4, 19, 25, 26, 33, 39, 48, 

52, 64, 80 
Errors Report, 4, 70, 76 
European Attributes, 3, 39 
Excel™ files, 2, 3, 6, 7, 15, 16, 21, 22, 23, 

28, 36, 37, 39, 53, 57, 58, 64, 68, 113 

F 

FastFind, 2, 3, 9, 13, 28, 39, 45, 46, 58, 115 
File Open, 7, 43 
Finance Charge, 3, 40, 48 
Foreign Exchange Reference, 3, 5, 9, 40, 

53, 104, 118 
Formatting a list in the Excel folder, 22, 23, 
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Highlighting a Range, 16 
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Identifier, 8, 12, 26, 30, 34, 41, 46, 51, 54, 
75, 80, 82, 83, 84, 85, 86, 87, 88, 89, 90, 
106, 107, 112, 113, 116, 117, 118, 119, 
120 

Identifiers, 26 
Input Folder, 3, 23, 57 
Input Folders, 3, 57 
Inputting orders, 2, 7 
International Liquidity Report, 70, 73 
International Toolbar, 3, 42 

K 

Kick outs, 39, 41, 44, 74, 81 

L 

Liquidity Reports, 4, 44, 70, 78 
Local Price, 12, 55 

M 

Making corrections in the Tabular folder, 9 
Making corrections in the Unknown folder, 9 
Manual Entry, 7 
Manually Entering Orders, 23 
Manually Setting Order Attributes, 8 
Merged data, 5, 92, 93 
Merging Columns, 2, 24, 28 
Mismatch, 3, 4, 7, 13, 39, 42, 44, 50, 51, 66, 

71, 76, 79, 87 
Mismatch Report, 3, 4, 42, 71, 76 
Mismatch Reporting, 3, 4, 42, 76 
Moving Field Delimiters, 2, 29 

N 

New, 3, 36, 42, 53, 54, 118 
No columns, 5, 96 
No Security, 4, 88 
No Shares, 4, 88 

O 

Odd Lot, 3, 4, 7, 39, 43, 44, 58, 66, 71, 77, 
88 

Odd Lot Report, 3, 4, 43, 71, 77 
Odd Lot Reporting, 3, 4, 43, 77 
Open File, 3, 15, 43, 54 

Opening an Excel� Spread Sheet, 15 
Order Status, 3, 4, 43, 77 
OTC Market Maker Report, 4, 72 
Output folders, 7, 26 
Output Folders, 3, 59 
Overview, 2, 6, 7 
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Parallel orders, 5, 98 
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Pasting, 2, 21, 24, 25 
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Price Alert, 33, 43, 75, 77, 116, 119 
Price Error Reporting, 4, 77 
Price Off by…%, 43, 77 
Price Out Of Range, 3, 43, 72, 77 
Price Report, 4, 72, 77 
Problem Solving, 5, 92 
Processing Orders 

The Convert Button, 2, 8 

Q 

Quick Reference, 5, 115 
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Range Edit Controls, 119 
Reconciliation, 4, 39, 41, 56, 78 
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Reference prices, 43 
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Restricted Report, 3, 4, 44, 73, 78 
Restricted Reporting, 3, 4, 44, 78 
Right Click Menu, 3, 44 

S 
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Searching, 3, 45, 100, 102, 103, 105, 106, 

109, 110 
Security Alert, 33, 75, 116, 119 
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Security ID, 3, 46, 54, 58, 119 
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45, 46, 53, 54, 90, 105, 106, 112, 113, 
119 
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Set Order Attributes, 12 
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Side Selection, 3, 49 
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Technical Information, 5, 114 
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The Business Solution, 2, 6 
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Typing in orders manually, 7 
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Undefined Security Identifiers, 4, 5, 58, 87, 
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Unknown Account Warning, 4, 81 
Unknown Folder, 4, 64 
Unknown Side, 4, 5, 58, 81, 90 
Unknown Side Warning, 4, 81 
Unstructured files, 6, 7 
Updating Data, 5, 111 
Upload Procedures, 2, 30 
Upload Reconciliation, 3, 4, 41, 78, 81 
Upload Reports, 4, 74 
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View Sub-Account Allocations, 3, 38 
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